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NOTE: 

 

➢ All screenshots used in this User Guide were obtained while using CHECK FRAUD ALERT 

in the Chrome browser. If a Client user utilizes CHECK FRAUD ALERT in a different 

browser, certain screens may display differently than what is seen in this guide because of 

the browser’s particular configuration. However, even though screens may appear slightly 

different, the functionality will remain the same across all browsers. 

NOTE: 

➢ As of 08/20/2021, the FPHQ platform and all modules thereon are supported for the 

following modern browsers only: 

Chrome: 

Firefox: 

Firefox Extended 

Support Release: 

Edge: 

Last 4 versions 

Last 4 versions 

Latest 

Last 4 versions 
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I. WELCOME TO CHECK FRAUD ALERT! 
 
 

 

A. How to Access Service 

 

Sign into your Business Plus online banking account & from the Home page, click on the “Fraud Alert” link. 

 

 
 

B. Introduction to CHECK FRAUD ALERT 

 
1. The CHECK FRAUD ALERT service is highly configurable. This guide will outline all CHECK FRAUD 

ALERT functionality, but it is important to note that some features will only be available if the feature has 

been enabled by the financial institution (FI) and/or the Client user has been granted the appropriate user 

privilege required to access the feature. 

 
2. The table below lists the CHECK FRAUD ALERT positive pay types available for each account enrolled 

in CHECK FRAUD ALERT, a description of expected behavior and protection level ranking. CHECK 

FRAUD ALERT relies on Clients to make daily decisions, when required, for the check activity that 

occurs on their account. When accounts are enrolled, a default setting can be established for the 

system to return or pay a transaction if the user fails to do so by the established end-of-day cut-off time. 

The last column in the table defines the default settings available for each type of positive pay service. 

 
 

Positive Pay 
Type 

 
Service Description 

Protection 
Level 

Default Setting 
Options 

 
 

 
Standard 

Positive Pay 

This service requires the Client to provide a list of checks that have 
been issued or voided on an account (Issue Items). The issue items 
for each account must include, at a minimum, a check serial 
number, amount, and status (issued, voided, stopped). The 
financial institution compares each check presented for payment 
(Item) against the list of issue items. If an exception is identified, 
designated Client users are alerted to make a pay or return 
decision. 

 
 
 

Medium 

 
 
 

Pay or Return 
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Payee Positive 
Pay 

 

This is an add-on feature to Standard Positive Pay. If this feature is 
utilized, Clients are required to provide the payee name for each 
issue item. The financial institution will compare the name in the 
issue item against the name that appears on the “Pay to the Order 
of” line of the check presented for payment. A scoring method will 
be used to determine the likelihood of a match, and if the score falls 
below the established threshold, the item will be flagged as an 
exception. It is important to note that payee name scoring is subject 
to a lot of variables. Scoring can fail items that should pass if 
Clients fail to perform best practices. Refer to Section IX. Payee 
Positive Pay Tips & Best Practices for more information. 

 
 
 
 

 
High 

 
 
 
 

 
Pay or Return 

 
Support 

Multiple Payee 
Names 

CHECK FRAUD ALERT has the ability to accept multiple payee 
names in an issue item file and validate multiple payee names on 
checks presented for payment. Multiple payee names can be placed 
on a single line or multiple lines. 

 
 

High 

 
 

Pay or Return 

 
 
 

 
Reverse 

Positive Pay 

 

This service does NOT require Clients to provide a list of issued 
items. Clients will need to login every day to view checks presented 
for payment and select the checks they want to return because the 
concept of an exception does not exist since there is no list of issue 
items to compare items against. However, Clients may request the 
financial institution establish a maximum check amount per account 
(Exception Limit). If this optional setting is enabled, an alert will be 
sent to designated Client users ONLY when a check is presented 
that exceeds the maximum amount established. 

 
 
 

 
Low 

 
 
 

 
Pay 
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3. CHECK FRAUD ALERT offers alerting (notification) to call designated Client users to action when 

required. CHECK FRAUD ALERT is designed to ensure notifications are relevant, but each Client can 

advise the financial institution of notification levels that best suit their needs. Email alerts are standard. 

Clients can receive texts alerts if the FI has chosen to enable the text alerts feature. 

 
4. The table below outlines a list of events that trigger an alert to a Client, a description of the triggering 

event and if the alert type is Standard or Optional. 

 
 

 
Alert Type 

 
Description 

Standard or 
Optional 

 
Exception Alert 

Occurs when a check is presented for payment that does not match the 
issue information provided or if an exception limit is set on an account 
enrolled in Reverse Positive Pay. 

 
Standard 

 

Issuance File Load 
Alert 

 
Occurs when an issue file is loaded. The alert contains status 
information to indicate if the issue item loaded properly or if the issue 
item failed due to errors. 

 

 
Optional 

 

 

5. When an account is enrolled for CHECK FRAUD ALERT, one of three levels of notification can be 

established for exception alerts. The notification level options, description and a sample are provided in 

the table below. 

 
 

Notification 
Level 

 
Description 

 

Transaction Alerts 
 

One alert for each exception identified. 

 
Account Alerts 

 
One alert per account when one or more exceptions are identified. 

 
Service Alerts 

 
One alert per client when one or more exceptions are identified on one or more accounts. 
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6. Sample Alerts – Account Level 

Via Email: 

 

 
 
 
 
 

 
Via Text: 
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7. Sample Alerts – Transaction Level 

Via Email: 

 
 

Via Text: 
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8. Sample Alerts – Service 

Via Email: 

 

 
 

 
Via Text: 
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II. CHECK FRAUD ALERT DASHBOARD BOX 
 
 

 

 

A. Using the Dashboard 

 
1. The Dashboard is the default landing page within the Client portal. If CHECK FRAUD ALERT is 

enabled, a CHECK FRAUD ALERT box will be displayed. Summary information on current check 

transactions and status will be displayed for accounts the user has been granted access. Active links 

are embedded within the CHECK FRAUD ALERT box to permit users to navigate from the dashboard 

landing page into the CHECK FRAUD ALERT service module or directly to transactions in the status 

selected. Dashboard totals are updated in real time as transaction status values are changed by a 

user. 

 
The content displayed in the CHECK FRAUD ALERT summary box includes the following: 

 
 

 
 

 
 
 

Service Name In the example provided, clicking CHECK FRAUD ALERT on the left in the title bar will 
direct the user to the main menu. 

End of Day Cut-Off Time Displayed in the second bar, the time of day indicates when transactions that require 
decisions will no longer be eligible for user decisions. 

Exceptions Clicking on the dollar amount hyperlink on the Exceptions line will direct the user to a 
filtered view of Transaction History that will display only exceptions that require a 
decision. 

Pending Approval If Dual Decision Approval has been enabled, the Pending Approval hyperlink will appear 
in the Dashboard. Clicking on the dollar amount hyperlink on the Pending Approval line 
will direct the user to the Check Transaction Approval screen, where the user can 
approve or reject any transactions that are pending approval by the user. For more 
information about Decisioning Dual Approval, please refer to Section VII, Decision 
Dual Approval. 
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Set to Pay / Set to Return Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines will 

expand the view to display a breakdown of the total for each category. System Pay or 
Return indicate transactions that will pay or return if no action is taken due to the default 
status. User pay or return indicate a Client user decision has occurred. FI pay or return 
indicate an FI decision has occurred on behalf of the FI. 

 
 

 

 
Transaction History The user can click on the dollar amount link for any category to be directed to a filtered 

view of the Transaction History. In the above example, the user has clicked on the dollar 
value of Exceptions on the Dashboard and is directed to a view of exception transactions 
that require decision. 

 

Please refer to Section V, Subsection A, Transaction History, for more information 
on this function. 
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2. From the Client Dashboard, a user can navigate to the CHECK FRAUD ALERT Module by clicking 

Change Module > CHECK FRAUD ALERT. 

 
 

 

 
 
 

B. Creating Client Users 

NOTE: 
 

➢ Please contact the cash management department if you would like to add 

additional users. 

 Email: cashmanagement@bankcherokee.com 

 Phone: 651-291-6240 

mailto:cashmanagement@bankcherokee.com
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III. MANAGING ISSUE ITEMS 
 
 

 
 
 

 
Certain types of positive pay services require Clients to maintain a list of issued items for the financial 

institution to compare presented items against so exceptions can be identified. 

While issue items can be added after a check has been presented for payment, it is highly recommended 

that Clients enter or load issue items prior to disbursing paper checks to payees, as failure to do so could 

result in denial of payment if the check is presented at the teller line for deposit or to be cashed. 

If issue items are entered or loaded on accounts configured for positive pay types that do not require a list, 

CHECK FRAUD ALERT will ignore them. 

When an issued item is entered or loaded into CHECK FRAUD ALERT, the status and disposition of the 

issued item is tracked. The table below describes the status and disposition labels associated with issue 

item management. 

 
 
 

Labels Description 

 
Issued 

 
A status defined by the Client that indicates a check was issued. 

 
Voided 

 
A status defined by a Client that a check was issued but later voided and not distributed. 

 
Stopped 

 
A status defined by a Client or designated by the FI if the FI chooses to control this status. 

 
Cancelled 

A status defined by a Client or FI user to indicate an issued check is to be cancelled and 

removed from the outstanding issue items in the Issue Warehouse. 

 
Available for Matching 

A status assigned by the CHECK FRAUD ALERT system when an issue item is entered or 
loaded by a Client. 

 
Used in Matching 

 

A status assigned by the CHECK FRAUD ALERT system when a check is presented for 
payment with a serial number that matches a serial number for an issued item. 

 
Outstanding 

A status displayed in the issue warehouse that indicates a check has not yet been presented 

for the issued item and it is still available for matching. 

 
Paid 

A status displayed in the issue warehouse that indicates a check has been presented against 
an issue item and it was paid by the system, Client user or FI. 
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Returned 

 

A status displayed in the issue warehouse that indicates a check has been presented against 
an issue item and it was returned by the system, Client user or FI. 

 
 

Purged 

 
A status assigned by the CHECK FRAUD ALERT system when an issue item that has not 
been used in Matching (outstanding) has been removed from the system. The purge period 
is defined by the financial institution. 

 

Deleted 
A status value displayed in Issue File Status that indicates that a file that was loaded was 
deleted by a Client or FI user. A history of the file load and delete action are retained but the 
issue items are removed as if they were never introduced to the system. 

 
Updated 

 

If an issue item is updated after it was loaded, history will be available in the issue item 
warehouse when the drop-down for an issue item is expanded. 

 
 
 

 

A. Test Mode 
 

Clients can request the FI enroll accounts with an inactive status and grant users’ access to the system to 

test issue file load. Issue items loaded while in test mode are marked as test issue items and will not be 

displayed in the issue warehouse or used for matching against presented checks. Clients must notify the FI 

when testing has been completed and they wish the account to be active. 
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B. Status Values 

 
Issued items can have a status of Issued, Voided or Stopped. 

 
 

1. Issued: The check has been issued and distributed for payment. 

 

2. Voided: The check has been voided by the maker. A check is usually voided prior to disbursement. A 

voided check cannot be used to make a payment or withdraw money from the account. 

 
3. Stopped: A check that has a stop payment placed on it. A stop payment is placed by a financial institution 

to cancel a check that has not yet been processed. 

 
4. Cancelled: A check that has been issued and a client user or FI user has opted to cancel the item. The 

outstanding issue item will be removed from the Issue Warehouse. 

 
5. Disable Stop Payments: The FI may choose to Disable Stop Payments in their configuration settings. The 

FI may choose to do this because they prefer to update those items in their core banking system. 

 
If stop payments are enabled, the client user can: 

 

➢ Load issue files with stopped status items 

➢ Overwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided 

➢ Change a previously Stopped item to Issued or Voided via Issue Warehouse 

If stop payments are disabled, the client cannot: 

➢ Load issue files with stopped status items 

➢ Overwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided 

➢ Change a previously Stopped item to Issued or Voided via Issue Warehouse. 
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C. Manual Entry 
 

If the FI enables this feature, Clients can manually enter a list of checks that have been issued. To manually 

enter an issue item, the user must be granted the manual issue entry user privilege. 

The table below describes a list of fields that may be displayed in the manual entry screen, the criteria for the 

field to display and how the information entered will be used to identify exceptions when matching issue items 

to checks presented for payment. 

 
 

Field Criteria Use 

Serial # The check number/serial # is always required. To identify if the check was 
issued or presented more than 
once. 

Amount A dollar value is always required. Used to identify if the amount of a 
check has been altered. 

Payee 

Name 

The person(s) or entities to whom the check was intended to pay. The 
field will support entry of multiple payee names (maximum of 4 
allowed) by clicking “Enter” to input another name on the next line. 
This feature is optional, and the field will only appear for accounts 
configured for payee positive pay. If this feature is enabled, it is 
important to note that when a payee is required in an issuance 
file, values consisting of only white space (ex., all spaces) will be 
considered the same as an empty value and will not be accepted. 

Used to identify if the name in the 
“Pay to the order of” line has been 
altered. 

Status Each check should be accounted for, even checks that have been 
voided or have had a stop payment issued. The status value advises 
the FI if a check has been issued and distributed, issued, later voided 
and not distributed or issued, distributed and stop payment order was 
requested later. The issued and void status values will always be 
available for selection. The stopped status will only appear if the FI has 
enabled this option for Client designation. 

Used to determine if a check 
should be analyzed for matching 
(issued) or if a check was 
presented for payment that was 
previously voided or stopped. 

Issuance 
Date 

A date the check was issued and valid for payment is always required. 
The issuance date will always default to the current date, but the user 
can assign a back or future date. 

Used to determine if a check is 
presented earlier than intended or 
later than allowed. 

Additional 
Issue 
Fields 

Only available if the Issue Templates user privilege is turned on for a 
user. Additional issue fields are typically used if a Client requires 
CHECK FRAUD ALERT to retain information related to the issued item 
for reconciliation purposes. 

Used for account reconciliation 
purposes. Example: An invoice # 
associated with a check. 

 
NOTE: 

 

➢ The Manual Issue File user privilege must be enabled. 
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1. From the CHECK FRAUD ALERT module, click Perform > Manual Issue Entry. 
 
 

 
 

 
Account Select appropriate Account Number from the drop-down menu. 

Auto populate next 
check number 

When checked, the next check number will auto-populate in the following row. This feature is 
designed to eliminate serial number entry when checks are issued in sequential order. 

 
When unchecked, the next check number will remain blank until it is filled in by the user. 

Row Each issue item will be numbered in the order they are entered. Once the cursor is placed in the 
current row, an additional row will appear for the next entry. 

Serial Number Type the item serial number for this manual issuance file in the Serial Number field. 

Amount Type the dollar amount for this manual issuance file in the Amount field. Or use the up and 
down arrows in the Amount field to select a dollar amount. 

Payee Name Type the payee name for this manual issuance file in the Payee Name field. The Payee Name 
field supports the entry of a single payee, or multiple payees. 

 
Please see Step #3 below for in-depth information about the Payee Name field and 
Multiple Payee Names. 

 

Status 
 

Issued 
 

The check has been issued. 
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 Voided The check has been voided by the maker. 

 
Stopped The check has had a stop payment placed on it. 

It is important to note that if the FI has disabled stop payments, the Stopped status 
option will not appear in the drop-down menu. 

Issuance Date Click on the Issuance Date field and select a date from the calendar that this item was issued. It 
is important to note that on accounts configured for Active Account Reconciliation, the Manual 
Issue Entry screen will not permit selecting a date prior to the start date of the current 
reconciliation period. 

 

 

3. Payee Names: The Payee Name field supports up to four Payees. 

 

a. Click within the Payee name field to enter Payee Name(s). 
 

 

 

 
b. The view size on the Payee Name field can be enlarged by dragging bottom right corner of field box. 

The feature may not be available based upon the browser used. 

 

 

 

 
c. Input the Payee Name in the field. If there are multiple payees, an Enter (carriage return) must be 

used to input a second, third or fourth payee on separate lines in the field for it to be distinguished as 

different payees. 

 

 
 
 
 
 

 
If multiple payees are listed on a single line of the check, putting them on separate lines is not 
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applicable. 

 
 

d. The Payee Name field currently supports 500 characters in total. This count will include the carriage 

returns separating multiple payees. The 500-character limit is for the entire field, and not per payee. 

 
It is important to note that although 500 characters are allowed in this field, names might be truncated 
if using a fixed width template and the number of characters allowed in that column are less than 500. 

 
e. If Payee Positive Pay is enabled, the Payee Name field will not accept blank entries for items with 

Issued status, and will give an error message if an entry is attempted to be saved without a Payee 

Name. 

 

 

 
 

4. To edit any row, click in the fields to be edited and make changes. 

 
 

5. When all manual issuance files have been entered, click Save button. 
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6. The Manual Issuance File Status detail page appears. 
 

 

 
 
 

Load Date Date and time the file was loaded. 

Account Number The account number on each issue item. 

Serial Number The serial number of the issue item. 

Amount The amount of the issue item. 

Payee Name Name of the payee(s) from the issue item. 

Status Available_For_Matching The issued item is available for exception matching against an 

incoming check. 

 Duplicate Issuance This issued item is a duplicate and has already been issued. 

 
Used in Matching This issued item has been used in the exception matching 

against an incoming check. 

Issuance Date Date the item was issued.  

 
 

 

7. Click the Back to Status button to view the Issuance File Status page. For more information, please 

refer to Subsection G, Issue File Status. 
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8. Issuance Dual Approval: 

 

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the FI. In this 

circumstance, manual entry files must be approved by a second client user or, if no second user is 

available to approve the file, the client can request the FI approve the issue file. 

 
Please refer to Subsection G. Issuance Dual Approval for more information about the Issuance 

Dual Approval process. 

 
9. Disable Stop Payments: When the FI has disabled stop payments, client users cannot create new 

stopped issue items or modify previously stopped issue items. The FI can, however, feed stop pay items 

from the core banking system. 

 
a. If a user attempts to create a manual entry item with a serial number the FI has loaded a stop pay on, 

the system will not accept the item. 
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D. Issue Templates 

 

The purpose of issue templates is to make it easy to load issue items into CHECK FRAUD ALERT using files 

that can be generated out of most accounting systems. CHECK FRAUD ALERT provides organizations a 

variety of flexible options for providing a list of checks that have been issued or voided. 

 
Issue templates allow users to select from a list of file formats supported and identify where the required data 

elements are located within the file. 

 
Once a template has been set up, the template can be selected when loading a file to tell CHECK FRAUD 

ALERT how to utilize the data contained in the file. 

 
Multiple file templates can be set up, displayed and used. FI’s can create templates for Clients to use or the 

FI may choose to allow Clients to create their own templates. 

 
 

 
 
 
 

1. From within the CHECK FRAUD ALERT module, click Manage > Issue Templates. 
 

 

NOTE: 
 

➢ The Issue Template user privilege must be enabled. 
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A screen will appear that lists any existing templates that are available for view or edit, and a button to 

Create New Template. NOTE: Templates created by the FI cannot be modified by a Client. Templates 

created by the Client can be modified by the Client and the FI. Templates created by the FI can be 

viewed by clicking the eye icon in the Edit/View column. 

 

 

 
2. To view or edit an existing template, click the pencil icon for the appropriate template. The template will 

display with the date that the template was last updated. 

 

 

 
3. To delete an existing template, click the checkbox next to the Templates to be deleted and click Delete 

Selected. Templates that have the Delete option were built by the Client and can be deleted/edited by 

the Client user. Templates without the Delete option were built by the FI and cannot be deleted/edited by 

the Client user. 
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4. To create a new template, click the Create New Template button. 
 

 

 
 

The upper portion of the template screen will not change, regardless of the file type selected. The template 

name, file type and template status values are required. The header and footer fields are optional. 

 
Many accounting systems can export excel or fixed width files. Sometimes those files have header 

(beginning) rows or footer (ending) rows that contain data that is not required by CHECK FRAUD ALERT. 

 
When setting up a template, the Client can define the number of rows CHECK FRAUD ALERT should 

ignore at the beginning and end of the file. It is important to note that if the values are entered incorrectly, 

an issue file may load with errors or no items. 
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About Multi-Line Payee Name Separator: 

 
The Multi-Line Payee Name Separator field is optional. This feature allows the FI to enter a 

character that can be used to separate Multiple Payee Names that are on separate lines of an 

issued check. 

Currently, the system restricts the allowed characters to the following: ; | , - _ / . The user 

must be aware that using a separator character that appears elsewhere in the payee name or might 

conflict with the file itself can cause issues. Examples of scenarios where problems might arise are 

listed below. 

Within a Comma Separated file (.csv), different data fields are separated by a comma. Therefore, a 

comma cannot be used in the data field itself, or the .csv will read the comma as a separator before 

the next field. Therefore, listing two payees for an item in this way: “Elain Archeron,Nesta Archeron” 

will cause issues reading the .csv file. In this scenario, the user should select a multi-line payee name 

separator character that will not cause an issue, such as a semicolon. “Elain Archeron;Nesta 

Archeron” in the Payee Name field of the .csv file will process correctly. 

 
If the user selects a separator character that would ever appear in a payee name field, such as a dash 

(-), the system would then separate the data before and after the character as separate payees. For 

instance, if the user has selected a dash (-) as the Multi-Line Payee Name Separator, and a common 

payee used is “In-and-Out Burger”, the system will flag this as having multiple payees. In this case, the 

user should select a multi-line payee name separator that will not cause such issues, such as a pipe 

(|) or a semicolon for cases of multiple payee names. 

 
Please refer to Section IX Payee Positive Pay Tips & Best Practices for more information about 

multiple payee name handling. 
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The mapping section below will display based on the file type selected. It is important to note that not all 

fields/options seen in these graphics may be available for your organization based on settings 

configured by your financial institution. 

Excel and separated files will require Clients to define the column data elements that will be found. 
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Fixed Width files will require the Client to define the start and end position in which the data element 

is located. 
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The mapping section on the lower part of the screen displays the required fields. The Check Serial 

# and Amount fields are always required. The Client must specify if the amount data in the file to be 

imported will or will not contain decimal points. For example, if the Amount value is set to Fractional 

Dollars, then 100, 100.0 and 100.00 are all processed the same. If the Amount value is set to 

Whole numbers of cents, the system will divide by 100 and save it as a dollar value. For example, a 

value of 100 would be saved as $1.00 in the system. 

 
 

The Client may choose to import additional data by checking the Add box next to the desired data element. 

 

 
If the Status box is not checked (as shown below), CHECK FRAUD ALERT will load all issue items with a 

status of Issued. If the Client file represents Voided items as a negative number, the Client can check the 

box Treat Negative Amount as Void and CHECK FRAUD ALERT will status any item in the file with a 

negative value as Voided. Issuance with a $0 amount will also be treated as void. 
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If the Client checks the Status box additional fields will display as shown below. If the Client’s accounting 

system exports issue items with an Issued and Voided status, no additional action is required. 

 

 

 

 
It is important to note that if the Status box is checked for a template, and this information is not provided in 

the issue file loaded, the system will give each record an ISSUED status. In addition, the STOPPED status 

may not appear in the Template configuration screen if the FI has disabled stop payments. 

If the accounting system used exports issued items with a value of X and voided items with a value of Y, 

the user can identify the values as shown below so CHECK FRAUD ALERT can translate the data 

appropriately when importing the data. 
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A description has been provided below to define system behavior if additional data elements are included. 
 

 
Account # If the account box is selected, the user can import one file that contains issue items for 

multiple accounts. If the account box is NOT selected, when a Client user loads a file through 
the Client portal, CHECK FRAUD ALERT will require the user to select the account the checks 
were issued on. 

Issuance Date If the issuance date box is NOT checked, CHECK FRAUD ALERT will default the issue date to 
date the file was loaded. If the issuance date box is checked, the file must contain an issuance 
date for each item. For Excel files, CHECK FRAUD ALERT will translate the data format used in 
the file. For separated and fixed width files, the Client must define the date format being used as 
shown in the screenshot below. It is important to note that the formats displayed are examples 
only, a complete list of date formats can be found at: 

 
https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.html#patterns 

 
 
 
 
 

 
 
 

Payee Name The Payee Name box will only appear if one or more accounts are configured for payee positive 
pay. If the payee name box is checked, CHECK FRAUD ALERT will require the payee name for 
accounts configured for payee positive pay. If payee name is provided for accounts not enrolled 
in payee positive pay, the payee name data will be ignored when the file is loaded. For Excel or 
delimited files, the complete and single payee name is expected in a single column. For fixed 
width files, the complete and single payee name must be contained in the file between the 
starting and ending position. 

 

It is important to note that when a payee name is required in an issuance file, values 
consisting of only white space (i.e., all spaces) will be considered the same as an empty 
value and will not be accepted. 

 

If Multiple Payee Names feature is enabled, the Issuance Payee name may display more 
than one payee. 

https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.html#patterns
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E. Loading Issue Files 
 
 

 
CHECK FRAUD ALERT allows Client users to load issue files into the system for use in matching. CHECK FRAUD 

ALERT accepts these files in a variety of formats, used in conjunction with file templates (covered in the previous 

subsection). 

1. From the Client Portal: 

 
a. CHECK FRAUD ALERT module, click Perform > Issue File Load. 

 

 

 

b. The Load Check Issuance File page appears. 

 

 

NOTE: 
 

The Load Issuance File user privilege must be enabled. 

If Multiple Payee Names feature is enabled, CHECK FRAUD ALERT will support more than one 

payee name in the Payee Name field of issuance files. Please see Step #2 below for more 

information. 

If Payee Name is a required field in the issuance template used, it is important to note that 

issuance files in which the payee name field contains values consisting only of white space 

(ex, all spaces) will be considered the same as an empty value and will not be accepted. 

Issue file loading will strip and ignore dollar signs on dollar amounts, and double and single 

quotations around data fields. 

For best results, users should not load issue files with mixed account numbers unless they 

have access to all the listed accounts. Loading issue files with account numbers for which the 

user has no access will cause errors. 

There is a 100-character limit on issuance file names. 
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c. Select the Template drop-down box to select from a list of existing templates. Select one of the 

available templates listed. If only one template is available for a client, the drop-down box will select 

that template by default. 

 

d. If the template selected was created without the Account field enabled, then a drop-down box will 

display so that an Account can be selected. Select from the list of accounts. If only one account is 

available for a client, the drop-down box will select that account by default. 

 

 
 
 

e. The file upload interface will appear. Click the Browse button to select the appropriate file. 
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f. Once the file is selected, it will be displayed in the upload interface. 
 
 
 

 
 

 
Remove The file will be removed from the page. 

Browse Use Browse to locate the file you want to load. 

Upload The file will be uploaded. 
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g. The Status Bar will display the current status of the file. 
 
 

h. If errors were encountered during the initial processing of the issuance file, the Parse Errors display 

will appear, allowing the user to view the error detail within the file. The most common reason this 

error would appear is because the file contains improper formatting. At this point, the user will have 

the option to: 

 
➢ Correct those errors. 

 
➢ Delete individual errors. This feature only displays if there are errors in the file and is only 

available until errors have been corrected and the file is saved. 

 
➢ Delete all errors. This feature only displays if there are errors in the file and is only available until 

errors have been corrected and the file is saved. 

 
o This will retain the totals and counts for audit history. 

 
➢ Discard the file. This feature shows up when there is an error in the file. This option is not 

available after corrections have been made and saved. 
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This will remove the file and its contents from the system. 

 

 

 
In this case, the account numbers in the issuance file were entered incorrectly and they need to be 

corrected before the file can be fully processed and loaded. 
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i. Click on any of the fields highlighted in red to make updates or changes. 
 
 

 

In this example, the user is presented with an account number drop-down so they can choose the 

correct account number for the issuance item. 

 

 
j. Once all errors have been corrected, the red highlights are no longer visible, and the file can be 

reprocessed by clicking the Save and Submit button. This feature is only available until all errors are 

corrected, deleted, or discarded. 
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k. The file will be returned to processing. 

 

 
 

l. If the file processes successfully, the user will be able to view the details on all the items in the file. 
 
 

 

If there are no errors in the file during the initial load, then the file will automatically display as 

approved and complete. 
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If an issuance file needs to be deleted for any reason, the user can click on the Delete button and the file will 

be removed. Deleting a file will retain item counts and totals as audit history. NOTE: Files are only eligible 

for deletion if every item in the file is still in an available for matching status. If just one item in the file 

has been paid, the file cannot be deleted. 

 
 

 

2. Multiple Payees: 

 
CHECK FRAUD ALERT has the ability to support customers with multiple payee names on issued items. 

The system can score multiple names on a check against information provided in the issuance file. 

 
a. When the Client user loads issue files into the system, the loaded file is processed with the Issue 

Template set up within CHECK FRAUD ALERT. The Issue Template allows for selection of a 

Multi-Line Payee Separator, a character chosen to separate the names of multiple payees in the 

issue file. 

 
b. If multiple payees are listed on a single line of a check, no action needs to be taken. 

 
c. If multiple payees are listed on two or more separate lines on a check, the multiple payee separator 

character (which should match the one designated in the template), must be used between each 

name. In the example below, the Multi-Line Payee Name Separator designated in the Issue Template 

is a pipe (|). The issue items shown are entered with the pipe separator between each name, with no 

spaces. 

 

 

When the issue file is loaded, the system would then separate the data before and after the character 

as separate payees. 

 
Please refer to Subsection D of this Section, Issue Templates, for more information about 

Multi-Line Payee Name Separators and how best to utilize this feature. 
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3. Direct Send Issue Files: 

 
If supported by the FI, this feature allows the client to send their issue files to their financial institution via 

SFTP or another file transfer method so that the FI can load those issue files to CHECK FRAUD ALERT 

for processing. It is important to note the following guidelines: 

 
 
 

 
NOTE: 

 

➢ Only one template type can be selected for use by a Client. However, in some cases, an FI can 

load a direct send issuance file which is mapped to a different issue template via a special 

process. For more information, speak to your Financial Institution. 

➢ The account number must be included in the issue template assigned. 

➢ The template must have mapping set up to accommodate all account configurations. If one 

account is set for payee positive pay and one account is set for standard positive pay, then the 

payee name should be mapped in the template; however, it is not required for accounts 

enrolled in Standard. 

o In the example below, there is an issue item for two accounts, each configured 

differently. Account 12121212 is set for standard positive pay and 12345678 is set for 

payee. The file loads without incident if no payee is included for the standard positive 

pay account (even though the issue template defines the position/location) because 

CHECK FRAUD ALERT knows the payee name is not required for account 12121212. 

However, if the payee name is not provided for account 12345678, the file will fail. 

➢ If the user has been configured to receive alerts, an alert email will be received once the direct 

send issuance file has been transferred to the system. If the file loaded with errors, the alert 

email will inform the user that the file load loaded with errors. In this particular case, the user 

should check the Issuance File Status page in CHECK FRAUD ALERT before taking action. If 

the user file status column indicates the load did fail, the user should review their direct send 

issue file carefully, correct any problems, and resubmit. If the status column indicates the file 

has “edits_pending,” click View to open the issue file and make edits within CHECK FRAUD 

ALERT. 

 
 
 
 

 

4. Issuance Dual Approval: 

 

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the FI. In this 

circumstance, loaded issue files must be approved by a second client user or, if no second user is 

available to approve the file, the client can request the FI approve the issue file. 

 
Please refer to Subsection G. Issuance Dual Approval for more information about the Dual 

Approval process. 
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5. Disable Stop Payments: When the FI has disabled stop payments, client users cannot create new 

stopped issue items or modify previously stopped issue items. The FI can, however, feed stop pay items 

from the core banking system. 

 
a. If a user attempts to load an issue file with serial numbers the FI has loaded a stop pay on, the 

system will not accept the file. 
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F. Issue File Status 

 

The purpose of the Issue File Status feature is to provide Client users the ability to view and/or manage issue 

files loaded or manually entered by the client. The disposition or status of the file is available. If enabled by 

the FI, CHECK FRAUD ALERT also offers an option for FI and/or Client users to receive issue load alerts 

that will inform if an issue file is loaded successfully or loaded with errors. (Please refer to Appendix A – 

CHECK FRAUD ALERT Message Alerts to see examples of these alerts.) Authorized client users can 

also manage these files as outlined in the next section. 

 
1. View Issue File Status 

 
 

 
 

a. Within the CHECK FRAUD ALERT module, click View > Issue File Status. 
 
 

 

NOTE: 
 

➢ The View Issuance File Status user privilege must be enabled. 
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b. The Issuance Files Status page appears. 

 

 

 
c. To filter the date range of files shown, click on the Date Range drop-down. 
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d. To narrow the search results, click Filters and a window containing additional search criteria will 

appear. 

 
 

 
 
 

Issuance Load ID The ID number associated with the specific file. 

Status Client_Approved The file was approved by the client. 

 

Client_Discarded Client discarded means a client user decided to discard the issue file 
before it was fully processed into the database. 

 
Client_Rejected If Issuance Dual Approval is configured for a client, client rejected 

means a client user rejected the issue file during the dual approval 
process. 

 
Deleted A deleted file has been processed into the system but was removed by 

an FI or Client user. The file information will still be in the system and 
can be found in the Issue warehouse. 

 
Edit_Pending A file in this status was loaded with errors. Before the file can be 

processed into the database and be displayed in the issue warehouse 
or be used in matching, the errors will need to be cleaned up or 
removed from the file. 

 
Failed The file failed to load. 

 
FI_Approved The file was approved by the FI. 

 
FI_Rejected If Issuance Dual Approval is configured for a client, FI rejected means 

an FI user rejected the issue file during the dual approval process. 

 
Ineligible_Items The file contains ineligible items, and the load did not complete 

successfully. Ineligible items will need to be removed and the file 
reloaded. 

 
Loading The file is loading. 

 
Processing The file is processing. 
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 Queued The file is in line awaiting a status change. 

 
Suspended The file has been suspended. 

 

“Suspended” status can be related to the Issuance Dual Approval 
feature. Please refer to Subsection G. Issuance Dual Approval, for 
more information about this feature. 

 
System_Approved The system is set to default approve the file. 

 
System_Discarded Discarded files are files that a client user loaded to CHECK FRAUD 

ALERT and had errors that need to be cleaned up. If the errors are not 
cleaned up by deadline displayed under the progress bar, which is 
three days, the file will be automatically discarded by the system and 
no record of it will be kept. 

 
Test_Approved In test mode a client user is able to load issue files to make sure that 

the issue template that was created and the file loaded to the system 
correctly. This function informs the user if the file will process in the 
regular user interface, but items are not available for matching in test 
mode. 

Min Amount The minimum dollar amount of the entire file. 

Max Amount The maximum dollar amount of the entire file. 

 
 
 
 
 
 

e. Once search criteria are selected, click Apply to narrow your search results. 
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f. Search results are displayed in pages of 25 items. If the search contains more than 25 issue files, the 

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results 

to review all results. 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
Issuance Load ID The ID number assigned by CHECK FRAUD ALERT when a file is loaded. Their 

value only comes into play if the FI needs to contact ACH Alert regarding an 
issuance file loading problem they cannot troubleshoot themselves. These pieces 
of information should be provided in any helpdesk ticket opened. 

File Name The file name assigned by the Client at load time. If the transactions were 
manually entered the file name will appear with a prefix of MANUAL followed by a 
system generated number sequence for ease of differentiation. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Status Please see #4 in this section for a list of possible Status codes. 

Load Date/Time The date and time this file was loaded. 
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Transaction Count The number of transactions contained within the file. 

Transaction Total The total dollar amount of the transaction. 

View Displays View button if a file has no errors or is ineligible to be edited. It is 
important to note that authorized FI users can click View to get to the Delete 
button to delete a file. See below for more information. 

Manage Displays Manage button if the file contains errors that can be edited. See below 
for more information. 

 
 
 
 
 

2. Click the arrow (>) next to the Client Code to view more useful detail on each issuance file. 
 
 

 

 
File ID The ID number assigned by CHECK FRAUD ALERT once an issuance file is 

processed and committed to the database. If an Issuance Load ID is present 
but a File ID is not, the file was received but did not load properly or has not 
been processed all the way to the database. The File ID is useful when 
contacting ACH Alert Help Desk about a problem with a file. 

Template Name Issue Template used to load the issue file. 

Status Message Displays error messages, approval or rejection data, or indicates if an issue file 
has been deleted. 
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3. Click View button to view the individual issue files. The [File Name] page appears. 
 

 

 

 
File Status Bar Displays progress of issue file. This feature automatically refreshes and keeps the user 

informed on the status of the file as it goes from Queued to Approved or Failed. 

Load Date The date and time loaded of each item within the file. 

Account Number The Account Number of each item within the file. 

Serial Number The serial number of each item within the file. 

Amount The dollar amount of each item within the file. 

Payee Name If Applicable, the name of the payee of each item within the file. 

Status Available for Matching Items marked as Available for Matching are issue items that 
have loaded to the system but have not been matched to a 
presented item. 

 Used in Matching Items marked as Used in Matching are issue items that a 
presented item has been matched to. 

 
New Issuance Item This status will only display in a file that was not loaded to 

the database for processing. 

 
Ineligible for Modification Items ineligible for modification are items that have been 

matched to presented items and are either in a current 
status of paid or returned and can therefore no longer be 
modified. 

 
Duplicate Issuance Duplicate issuance items are issue items that duplicate 

previously loaded issue items exactly. 

Issuance Date The date of the issued item. 
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4. Manage Issue File Status 
 
 

 
 

a. Click Manage button to edit errors within an issue file. The [File Name] page appears. 

 
i. Correct Items. 

 
1) Fields highlighted in red have an error and are blocking the issue file from loading all the way 

to the system. 

 
2) When a highlighted field is clicked the user can either select the correct data from a dropdown 

or enter it in directly in the field. 

 
3) Once all errors have been corrected, the user can click Save and Submit at the bottom, so the 

file is reprocessed. 

 

NOTE: 
 

➢ The Load Issuance File user privilege must be enabled. 

➢ The View Issuance File Status user privilege must be enabled. 

➢ The Delete Issue File Status user privilege must be enabled. 

➢ The Manual Issue Entry user privilege must be enabled. 



Version 2.1.5 

Updated 06/24/2022 
Page 50 of 177 

© 2022 ACH Alert 

Proprietary & Confidential Information 

 

ii. Delete Items 

 
1) Individual items can be deleted from the errors screen if the option is available. 

 
2) The user would click the trashcan in the Delete column to delete any individual items. 

 
3) Once items have been deleted, the user can click Save and Submit at the bottom, so the file 

is reprocessed. 

 
a) The user can also click Delete All Errors at the top of the delete column. 

 
4) This will allow the rest of the file to process into the system. 
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iii. Discard a File 

 
1) An entire issue file can also be discarded. 

 
a) The user can click the discard button at the bottom of the screen. 

 
b) Another option is to allow the system to discard the file automatically after three (3) 

business days. 

 
In both instances, the system will act as if the file never existed and any issue information 

from the file will not appear in any reporting or view. 
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iv. Delete a File 

 
1) Users are also able to delete an issue file if none of the items in the file have been used in 

matching by clicking on the delete button. 

 
a) When a file is deleted the items will appear in issue views and reporting. 

 

 
 

5. Issuance Dual Approval: 

 

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the FI. In this 

circumstance, manual issue entry files or loaded issue files must be approved by a second client user or, 

if no second user is available to approve the file, the client can request the FI approve the issue file. 

 
Please refer to Subsection G. Issuance Dual Approval for more information about the Dual 

Approval process. 
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G. Issuance Dual Approval 

 

CHECK FRAUD ALERT offers the ability to support dual approval for issuance file loads. If enabled by the 

FI and configured for a client, any manual issue entry files or issue files loaded by the client will be held in 

“suspended” status until approved or rejected by a secondary user. 

 

 
 

1. If a Client User has manually entered issue items or loaded an issue file requiring dual approval, another 

client user must approve the issue file or manual entry file. Once the file is loaded and pending approval, 

a message will be sent via email or SMS within 30 seconds to client users with the Approve Issue File 

user privilege to alert them of files pending approval. 

 
2. Within the CHECK FRAUD ALERT module, click View > Issue File Status. 

 

 

 

3. The Issuance Files Status page appears. Files requiring dual approval will show a status of “Suspended”. 

Click the Manage button to review the file. 

 
 

NOTE: 
 

➢ Approve/Reject Issue Files permission must be enabled by the FI. 

➢ The Approve Issue File user privilege must be enabled. 
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4. The Issue File review page displays a File Status box at the top of the screen which outlines the current 

status of the file. The status bar will be highlighting “Approved/Rejected,” and will note if the file is 

pending approval. Approve and Reject buttons display in the File Status box. 

 

 
5. A list of each issue item contained in the file will display below the File Status box. Their status will 

display as “New Issuance Item.” The client user can review the entries to determine if the file should be 

approved or rejected. In addition, the client user can delete the file prior to and after approval by clicking 

the Delete button at the bottom of the screen. 
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6. If the file is to be approved, click the Approve Button. Once the file is approved, the file status displays 

that the file processing is complete. 

 

 

 
a. After the approval is complete, the issue items will display the status “Available for Matching.” The 

Delete button will still be available to delete a file after approval. 
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b. Returning to the Issuance Files Status page, the file will now display a status of “Client Approved.” 
 
 

 
 
 
 

 
7. If the file is to be rejected, click the Reject Button. 

 
a.  Once the file is rejected, the file status displays that the file has been rejected by [client username]. 

The individual issue items will no longer display in the issuance file status. 
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b. Returning to the Issuance File Status page, the file will now display a status of “Client Rejected.” 
 
 

 
 

 

 

H. Issue Warehouse 

 
CHECK FRAUD ALERT provides FI and Clients with the visibility to see the status of all issued items. 

Authorized Client users can modify items in the Issue Warehouse. Clients can use the Issue Warehouse to 

search for issued items for a Client or specific account using one of the many filtering options available. 

 
 

 

1. Within the CHECK FRAUD ALERT module, click View > Issue Warehouse. 
 
 

NOTE: 
 

If an issuance file is currently in “Suspended” status, the file is not released at EOD; but 

rather, will remain in this status indefinitely until approved or rejected. 

If an issuance file is currently in “Suspended” status, and the client level setting for 

Issuance Dual Approval is disabled, or client user privileges are removed before the 

affected issuance files are approved or rejected, the file will remain in the Suspended 

status but cannot be managed by the client user. In this circumstance, an FI user can still 

approve or reject the file to move it out of the Suspended status. 

NOTE: 
 

➢ The View Issuance Status user privilege must be enabled. 
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2. The Issue Warehouse page appears. 
 

 

 
 
 

3. To filter the date range of items shown, click on the Date Range drop-down 
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4. To narrow the search results, click Filters and a window containing additional search criteria will appear. 

 

 

 
Account Type an account name or the last 4 digits of the account number. 

Serial Number Type the item serial number for a specific issued item. 

Date Range 
Filter Type 

Issue Date: If selected, issue items will be filtered by the issue date rather than the 
load date. 

 
Load Date: If selected, issue items will be filtered by the load date rather than the 
issue date. 

Min Amount The minimum dollar amount. 

Max Amount The maximum dollar amount. 

Serial Number Range Min Serial Num Type the minimum serial number in the range 

 
Max Serial Num Type the maximum serial number in the range. 

Issue Type Issued The check has been issued for payment. 

 
Voided The check has been voided by maker. 

 
Stopped The check has a stop payment placed on it. 

Match Status Paid There was a presented item for the issued item, and it has been 

paid. 

 
Returned There was a presented item for the issued item, and it has been 

returned. 

 Outstanding There has been no presented item for the issued item, it remains 
outstanding for 180 days as a default unless specified otherwise 
by your financial institution. 
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5. Once search criteria are selected, click Apply to narrow your search results. 

 
 

6. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the 

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results to 

review all results. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Item ID 
The ID number associated with the specific file once an issuance file is processed and 
committed to the database. 

Account Number Displays the Account Number for the item. 

Serial Number Displays the issued item serial number. 

NOTE: 
 

➢ Issuance data is available for 1 year as the default setting, but this can be 

configured differently by the FI. 

➢ If Additional Issue Fields are being used, a section to filter by that data will display. 
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Payee Name Displays the name of the payee for the item. 

Issue Type Issued The check has been issued for payment. 

 
Voided The check has been voided by maker. 

 
Stopped The check has a stop payment placed on it. 

Match Status Paid There was a presented item for the issued item, and it has been paid. 

  
Returned 

 
There was a presented item for the issued item, and it has been 
returned. 

 
Outstanding There has been no presented item for the issued item, it remains 

outstanding. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Amount Displays the dollar amount for the issued item. 

Load Date/Time Date and time the item was loaded. 

Issuance Date The date of the issued item. 

Update Click the pencil icon to update item’s Amount, Status, or Issuance Date. 
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7. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The 

information shown in this drop-down is an audit history of all the activity that has occurred on the issue 

item. 

 
 

 

 
Status Issued The check has been issued for payment. 

 
Voided The check has been voided by maker. 

 
Stopped The check has a stop payment placed on it. 

Payee Displays the payee name of the issue item. 

Amount Displays the dollar amount for the issued item. 

Issue Date The date of the issued item. 

Updated By The user who updated the issue item. 

Updated Date/Time The date and time this issued item was updated. 

 
 

 

8. Modifying Issue Items. 

 
a. Issue items can be modified by users with a Load Issue File or Manual Issue Entry privilege. Issue 

items can only be modified if the match status = outstanding. Click the edit pencil button under the 

Update column to update the issued item. 
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9. The Update Issue Item pop-up window appears. 

 

 

 
Serial Number Check serial number. This cannot be updated on an existing issued item. 

Amount Amount of the issued item. The amount can be updated. 

Payee Name The name of the Payee associated with the specific issued item. The payee name can be 
updated. 

Status Issued The check has been issued. 

 
Voided The check has been voided by the maker. 

 
Stopped The check has a stop payment by the maker. 

 

It is important to note that if the FI has disabled stop payments 
in their configuration, Stopped may not be an option in the 
drop-down menu on this pop-up screen. 

 Cancelled The check is being cancelled by the maker. Please see next 

paragraph below. 

Issuance Date The date of the issued item. The issuance date can be updated. 

 
 

10. Issue Item Cancel: An outstanding issue item can be updated to Cancelled status. It is important to note 

that only outstanding issue items will have the option to be changed to Cancelled. Once the issue item is 

updated to cancelled, it will disappear from all views except Item Lookup, Active Reconciliation (if 

enabled), and Audit Report for historical purposes. 
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11. Click Save. 
 

 

 
 
 

12. A copy of the Issue Warehouse can be downloaded by clicking the Download As CSV button at the 

bottom of the Issue Warehouse screen. 

 

I. Item Lookup 

 
CHECK FRAUD ALERT provides Clients with the ability to look up all recorded data on individual issued 

items with the Item Lookup feature. 

 

 
1. Within the CHECK FRAUD ALERT module, click View > Item Lookup. 

 

 
 
 
 

2. The Item Lookup page appears. All fields are mandatory. 
 
 

 
 
 

Account Select the Account drop-down to display a list of the Client’s Accounts. 

Serial Number Enter the serial number of the item. 
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3. Once search criteria are selected, click Apply to complete the item lookup. 

4. Search results for the item will be displayed. Within this screen, the lifecycle of the issued item will be 

displayed. 
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J. Other Options Prior to Item Presentment 

 
If a Client needs to make changes to an item prior to item presentment, there are three options for doing so 

within CHECK FRAUD ALERT. Examples of changes that would fall under this category would be when 

items originally issued are updated to Voided or Stopped status, or to overwrite existing item information such 

as changes in amount and/or payee. It is important to note that if the FI has disabled stop payments, it 

will affect whether a client user can perform these functions in some instances. Please see 

Subsection B. Status Values within this Section for more information. 

 
1. Modifying Issue Items 

 
Issue items can be modified in the Issue Warehouse. Please refer to previous Subsection H. Issue 

Warehouse, for more information. 

 

 
2. Manual Re-Entry 

 
To change individual items previously submitted, a Client user can overwrite the previous item as follows: 

 
a. Within the CHECK FRAUD ALERT Module, click Perform > Manual Issue Entry. 

 

 
 

The Manual Issuance File Entry page appears. For definitions of the fields available on this screen, 

please refer to Subsection C of the current Section. 
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b. Create a Manual Entry for the item to be changed. The serial number must match the previously 

submitted item. Fill out all fields, updating the fields that need to be overwritten with the correct 

information. 

 
c. When all pertinent manual issuance files have been re-entered, click Save button. 

 
d. The Manual Issuance File detail page appears. For definitions of the fields shown on this screen, 

please refer to Subsection C of the current Section. 
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3. File Reloads 

 
To change multiple items that were previously submitted, a Client can use the Issue File Load function to 

reload and overwrite previous items in an Issue File. 

 
a. Once you have prepared your Issue File with all items that need to be overwritten, including the 

corrected information in the appropriate fields, upload the Issue File. Refer to Subsection E. 

Loading Issue Files, for more information. 

 
4. Prior to item presentment, these changed/overwritten items can be seen in the Issue Warehouse (please 

refer to Subsection H within this Section for information on how to access the Issue Warehouse). 

Once within the Issue Warehouse screen, click the arrow (>) next to the Client Code to view more useful 

detail on each issued item. The information shown in this drop-down is an audit history of all the activity 

that has occurred on the issue item. 

 
As you can see in the figure below, there are three issue items that have been updated/changed. The 

updates/changes from the most recent entries will overwrite the previously loaded issue item. 
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IV. EXCEPTION IDENTIFICATION 
 
 

 

 

CHECK FRAUD ALERT is configured to identify exceptions on issue items in a specific order. Once the first 

exception is triggered on an issue item, the system does not evaluate the item further. If an item is flagged 

with an exception and is deferred to the Client user for decision, it must be noted that further analysis will not 

be performed. Client users should be conscious when paying an exception that other validations may not 

have been performed, so they should examine the item. 

Listed below are the possible Exceptions and the order in which they are flagged by CHECK FRAUD ALERT. 

It is important to note that the Exception Code and Reason below can be customized by financial institution so 

the example below may vary slightly from exception codes or reasons that appear in the Client interface. 

 

 
Exception 

Order 
Exception Code Reason 

1 Issuance not found Check presented where no issue item is found to match against. 

2 Issuance already used Check presented with a serial number previously presented. 

3 Issuance voided Check presented with a serial number of an issue item marked with a 
void status. 

4 Issuance stopped Check presented with a serial number of an issue item marked with a 
stop status. 

5 Issuance amount mismatch Check presented where amount of check differs from issue amount. 

6 Amount over limit Transaction amount is over the limit. 

7 Issuance date in future Check presented with a date that is before the issuance date on the 
issued item. 

8 Issuance stale dated Check presented with a date that exceeds the specified number of 
stale days for the account. 

9 Issuance payee mismatch Check presented where payee name differs from issue payee name. 

10 Exception reason missing This message will only appear to customers of FI’s that are in FI or 
Hybrid Matching mode. This exception reason is only used if the 
reason that is coming into CHECK FRAUD ALERT has not been 
mapped in PRO- 
CHEX. 
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V. MANAGING CHECK PRESENTMENT 
 
 

 
 

The primary objective of CHECK FRAUD ALERT is to give users the opportunity to make pay and/or return 

decisions on checks presented for payment on accounts enrolled for the service. The decision function is 

performed in the Transaction History screen. 

 

 
A. Transaction History 

 
 

 
CHECK FRAUD ALERT provides a function for Clients to search and view the status of checks 

presented on enrolled accounts, and to make decisions on presented items. Client users can use 

Transaction History to search for presented check items for a specific account using one of the 

many filtering options available. It is important to note that the default filter setting is Exceptions 

Only. Additional transactions may be available to view and decision (such as reverse positive pay 

items); however, this will not be displayed unless the Exception filters option is set to Show All 

Transactions. 

NOTE: 
 

Transactions are stored for 12 months. 

The Transaction History user privilege must be enabled to access this screen. 

If the user has been granted the Change Status user privilege and the transaction is 

available to decision, the Pay and Return buttons will be available for use. 

Transactions that will be paid will have green shading as a background. 

Transactions that will be returned will have yellow shading as a background. 

Transaction status cannot be changed after the EOD cut-off time. 



Version 2.1.5 

Updated 06/24/2022 
Page 71 of 177 

© 2022 ACH Alert 

Proprietary & Confidential Information 

 

1. View Transaction History 

 
Within the CHECK FRAUD ALERT module, click View > Transaction History. The Transaction History 

page will display all current day transactions for all accounts to which the user has access. 

 

 
 

Transaction ID Unique ID assigned by the CHECK FRAUD ALERT system when transactions are 
loaded. 

Account Number Account number the check was presented against. 

Serial Number The check number presented for payment. 
 

Clicking on the serial number will display the front and back images of the check. If an 
eye icon appears in the serial number column, this denotes an item that was processed 
with no serial number. Clicking on the eye icon will display the check image, if available. 

Credit This column will display if deposit information has been entered into the system. 

Debit This column displays checks. 
 

Current Status Pay Pay-System The system is set to default pay this check. 

  
Pay-FI The check was paid by the FI. 

  
Pay-User The check was paid by the Client User. 

 
Return Return-System The system is set to default return this check. 

   
Return-FI 

 
The check was returned by the FI. 

  
Return-User The check was returned by the Client User. 
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Date Date the check was presented for payment or loaded to CHECK FRAUD ALERT. 

Change Status If the user has been granted the Change Status user privilege and the transaction is 
eligible for a decision, a Pay or Return button will appear for use. If the transaction is 
not eligible for a decision, the button will display as ineligible. 

Exception If the transaction is an exception, an exception identifier will appear in this column. 

 
 
 
 

 

a. To filter the date range of items shown, click on the Date Range drop-down. 
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b. To narrow the search results, click Filters and a window containing additional search criteria will 

appear. 

 
 

 

 
Account Type an account name or the last 4 digits of the account number into the field to view transactions 

for one specific account or select an account from the drop-down menu. 

Min Amount Type the minimum check amount into the field. 

Max Amount Type the maximum check amount into the field. 

Serial Number Type the check serial number for a single transaction. A serial number range can also be defined 
by entering the minimum and maximum serial number. 

Exceptions The user may select from the drop-down to filter by one of the following: 
 

➢ Exceptions Only 
➢ No Exceptions 

 
The default will be set to “Show All Transactions”; however, the user can click the “Default” 
checkbox to select a different option to be the default for future filtering. 

Pending 
Approval 

If the FI has enabled Decision Dual Approval, this field may be available in the filter window. The 
user may select from the drop-down to filter transactions based on whether or not they are 
pending approval. 

 

➢ Yes – will display only transactions that are pending approval. 

➢ No – will display only transactions that are not pending approval 

The default will be set to “Show All”. 

For more information regarding Decision Dual Approval, please see Section VIII, Decision 
Dual Approval. 
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Items Defaults to Any Items. Select the drop-down to select one of the following: 
 

➢ Any Items: This includes all items, including client pay and adjust items. 
➢ Adjusted Items: Checks that were paid by a client user and either the amount and/or serial 

number was adjusted. 
 

Transaction 
Status 

Pay Pay-System The system is set to default pay this check. If a user takes no action 
before EOD, the check will pay. 

 
Pay-FI The check was paid by the FI. 

 
Pay-User A user changed the transaction status from a Return to a Pay status. 

 

Return Return-System The system is set to default return this check. If the user takes no 
action before EOD, the check will be returned. 

 
Return-FI The check was returned by the FI. 

 
Return-User A user changed the transaction status from a Pay to a Return status. 

 
 
 
 

 

c. Once search criteria are selected, click Apply to narrow your search results. 

 
 

d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, 

the results will be displayed on multiple pages. Use the navigation buttons at the top of the search 

results to review all results. 

 

 

 

e. Summary Debit and/or Credit transaction totals are also displayed at the top of the screen above the 

navigation buttons. 
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f. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The 

information shown in this drop-down is an audit history of all the activity that has occurred on the 

issue item. 

 

 

 
Positive Payee Type This indicates the type of positive pay that the account is set for: 

Standard, Reverse and Payee are the different types that could display here. 

Issuance Payee Name Name of payee submitted with the transaction presented for payment. 

Issuance Serial Number Serial number on the issued item uploaded by the client. 

Issuance Amount Amount on the issued item uploaded by the client. 

Issuance Date Date the issued item uploaded by the client. 

Original Serial Number Serial number submitted with the transaction presented for payment. 

Original Amount Amount submitted with the transaction presented for payment. This number may be 
different than what is displayed in the top line. For instance, if an item was adjusted in 
pre-scrub by the FI or if the FI is allowing Clients to adjust. 

Return Date Date the item was returned. 

Payment Date Date listed within the transaction file. 
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Return Reason Reason for return. Client users can click on the Return Reason hyperlink to open a pop- 
up window to select a different return reason as needed. 

 

 
 

Loaded Exception 
Reason 

 

This user documentation displays the standard exception reason labels; however, each 
FI can customize these during implementation so what is seen in the documentation may 
differ from what the User may see in the service if their FI has customized the labels. 

 

Please refer to Section IV. Exception Identification to view a list of all standard 
exception labels. 

Payee Match Score Payee scoring is addressed in the account configuration screen. The score displayed 
here is the score that was assigned by the payee analysis engine when the payee name 
on the check was compared to the payee name provided on the issue item. 

Payee Analysis Will display as Pass or Fail based on payee scoring. 

Adjust This button will allow users to adjust a serial number from the value presented to a 
new value and/or the amount from the amount presented to a new value. Please 
see subsection B. Optional Actions for more information on this function. 

Add Notes This feature allows FI and Client users to make notes regarding a transaction in Pay or 
Return status. Click on the Add Notes button to enter in pertinent information regarding a 
transaction. 

 
 

2. Change Transaction Status 

 
a. If the user has been granted the Change Status user privilege and the transaction is eligible for a 

decision, a Pay or Return button will appear for use. If the transaction is not eligible for a decision, the 

button will display as ineligible. 

 
3. Change Status – Pay 

 
a. If the Current Status on an issued item is set to Return, the Client can opt to change the status to Pay 

if the Client determines the check should be paid. 
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b. Click the Pay button under the Change Status column. 
 
 

 

The Change Status button will then change to Return, and the Current Status column will update to 

“Pay-User.” 

 
4. Change Status – Return 

 
a. If the Current Status on an issued item is set to Pay, the Client can opt to change the status to Return 

if the Client determines the check should not be paid. 

 
b. Click the Return button under the Change Status column. 

 

 
 

c. Check Return Reason pop-up window appears. Select the appropriate reason for the Check Return. 

Please note that the list of return reasons displayed are the system default but may vary depending 

on the way the financial institution defines them. 

 

 
 

Amount Incorrect The dollar amount is incorrect. 

Duplicate This item has already been presented. 
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Fraudulent Fraudulent item. 

Prior Stopped This item has a stop payment placed on it. 

Prior Void The item has been previously voided. 

Refer to Maker Refer to the maker of the check. 

Serial # Incorrect The serial number on the item is incorrect. 

Signature Irregular The signature does not match. 

Signature Missing The item is missing a signature. 

Stale Date The presented item has a date greater than the number of stale days allowed on the 
corresponding issued item. 

Suspect Item – 
Review Required 

The item is suspicious and possibly fraud – please review further. 

 

d. Click Save. 
 

 

 

 
e. The Change Status button will then change to Pay, and the Current Status column will update to 

Return-User.” 

 
5. A copy of the Transaction History can be downloaded by clicking the Download As CSV button at the 

bottom of the Transaction History screen. 

 
 

B. Optional Actions 
 

1. Confirm Paying Exceptions (May or may not be implemented by the FI) 

 
a. When the first exception is triggered on a presented item, additional validations are not performed. If 

the system detects a user pay decision on a check that additional validations were not performed 

(such as payee name analysis which is the last validation to occur), an image of the check will be 

presented to allow the user to visually inspect the check. The user must click the confirm button to 

finalize the pay decision. 

 
b. If the user decides to pay an item that is set to return, they will be presented with a pop-up window to 

confirm that this is the action they wish to take. The window will display an image of the check and 

other details for the user to review before confirming that they want to pay the item. 
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i. Click Pay to pay a check. 
 

 

 

 
1) A pop-up window with check information will display for the user’s review. 

 
 

2) Once the user has reviewed the information presented, they can decide to Confirm so that the 

check will be paid or to Cancel so that the check will be returned. 
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NOTE: 
 

➢ Items with duplicate presentment exceptions will not present the option to Add 

Issue from within Transaction History, as another item has been presented and 

paid with that serial number. 

➢ It is important to note the system will not allow the “Add Issue” function for a 

check with no serial number. 

➢ “Add Issue” will not be available for transactions in Reverse Positive Pay 

accounts. 
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C. Review Payee 
 

Although payee analysis is a good technology, it is not a perfect technology. The Review Payee functionality 

has been introduced to allow users to visually inspect presented items to ensure that fraudulent transactions 

that may not have triggered any exceptions are identified. 

 
1. If Payee Positive Pay is configured by the FI, the Review Payee feature may be available in Transaction 

History. Review Payee allows users to easily view non-exception items for transactions on accounts 

enrolled in Payee Positive Pay. 

 
2. From within Transaction History, the Payee Review button will appear at the top of the screen with the 

total number of non-exception items available for review in parenthesis. Click the Review Payee button to 

proceed. 
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3. The Payee Review screen appears. The Payee Review page will display all current day non-exception 

transactions for all accounts to which the user has access. 
 

 

 
Transaction ID Unique ID assigned by the CHECK FRAUD ALERT system when transactions are 

loaded. 

Account Number Account number the check was presented against. 

Serial Number The check number presented for payment. 

Amount The amount of the check. 

Issuance Payee Name of payee submitted with the issuance presented for payment. 

Image View The front image of the check will display for review 

Change Status The Return button is available for the user to change the status of the transaction to 
Return. 
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4. To narrow the review screen results, click Filters and a window containing filter criteria will appear. 
 
 

 

 
Account Type an account name or the last 4 digits of the account number into the field to view transactions 

for one specific account or select an account from the drop-down menu. 

Min Amount Type the minimum check amount into the field. 

Max Amount Type the maximum check amount into the field. 

Serial Number Type the check serial number for a single transaction. A serial number range can also be defined 
by entering the minimum and maximum serial number. 

 
 

 

5. Once search criteria are selected, click Apply to narrow your results. 

 
6. Results are displayed in pages of 25 items. If the Review Payee screen contains more than 25 items, the 

results will be displayed on multiple pages. Use the navigation buttons at the top of the review screen to 

review all results. 

 



Version 2.1.5 

Updated 06/24/2022 
Page 84 of 177 

© 2022 ACH Alert 

Proprietary & Confidential Information 

 

7. To change the transaction status to Return, click the Return button. 
 
 

 
 

9. A pop-up window will display to select a check return reason. Select the appropriate return reason, and 

click the Save button to proceed. 

 

 
 
 
 
 

8. 
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10. Once the return reason is saved, the user will be returned to the Review Payee screen, and the Return 

button will be displayed as an Undo button. If the user determines that the Return should be undone, 

clicking the Undo button will change the status back to Pay, and the screen will revert the button to 

Return. 

 

 
 

11. Click the Back button at the top of the screen to return to the Transaction History screen. 
 

 
12. The user is returned to the Transaction History view and may see the following alert message: 

 

 
13. Refresh the browser window to view the changes to the Transaction History screen. The user should see 

the previously changed item with the status of Return-User. 
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D. Add Notes 

 
1. If enabled, the Add Notes feature allows FI and Client users to make notes regarding a transaction. Click 

the Add Notes button to enter in the pertinent information regarding the transaction. 

 

 

 
2. The Add Notes pop-up window will appear. The user can enter up to 4000 characters in the Add Notes 

window. Multiple notes can be added within the 4000-character limit. Click the Cancel button to cancel 

without placing Notes on the transaction. Click the Confirm button to save the Notes to the transaction. 

 

 

3. The transaction will now show the entered Notes. 
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VI. MATCH PAID ITEMS 
 
 

 

 

CHECK FRAUD ALERT supports the ability for FI and Client Users to match issue items loaded to the 

system after cleanup has been performed to paid no issue exception items. 

 
 

 

A. Paid No Issue Match 

 
1. From the CHECK FRAUD ALERT module, click Perform > Paid No Issue Match. 
 

 
 

2. The Paid No Issue Match screen will display with the current month date range by default. To filter the 

date range, click on the Date Range drop-down, select the desired range, and click the Apply button. 

 

NOTE: 
 

➢ The Paid No Issue Matching user privilege must be enabled. 

➢ If Reconciliation is enabled and both the issuance and payment date precede the 

period start date, matching will not be allowed. 
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3. In the Client portal, the Paid No Issue Match screen must be filtered by Account to display data. Type an 

account name or the last 4 digits of the account number to generate the SmartSearch filter. 

 

 
4. Once the Account filters has been entered, the screen will display all outstanding issue items that can be 

matched to paid no issue items that have previously cleared. The first line in each row will present 

information on the outstanding issue item, and subsequent lines will be one or more paid no issue items 

that can be matched to the outstanding item. 

 

 

 
Select [all | none] The user can opt to select individual transactions by clicking the checkbox at the 

left of the row. If an issue item has more than one matching incoming transaction, 
the radio button for the transaction that the user wants to tie to the issue item must 
also be selected. 

 

The client can also select all transactions by clicking “all” in the Select column. 
The client can de-select all transactions by clicking “none”. 

Serial Number The serial number of the item. 
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Paid Amount Amount of the paid no issue item. 
 

Clicking the eye icon next to the paid amount will allow the user to view the check 
image of the paid no issue item. 

Issue Amount The amount of the outstanding issue item. 

Issue Date The date of the outstanding issue item. 

Issue Type Issuance type of the outstanding issue item. Matching can be performed to 
Issued, Voided or Stopped unmatched issuance items. 

Payee Name The payee name listed on the outstanding issue item. 

 
 
 
 

5. The user can view check images of the paid no issue items to compare to the outstanding issue item to 

determine if the items are indeed a match. Click the eye icon next to the paid amount for any paid item to 

view. 
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6. A pop-up window with images of the front and back of the check will display. If there is more than one 

paid items, examine both check images to confirm if either of them is a match. Click the Close button to 

close the check image view. 

 

 
 

 
7. Once a match has been determined to be found, click the checkbox at the left of the row to activate that 

row for matching. Click the radio button of the paid no issue item that matched the outstanding issue item. 

Single or multiple rows can be activated and selected for matching. 
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8. Once selections have been made, click the Match Selected button at the bottom of the Paid No Issue 

Match screen to complete the match. 

 

 

9. The Confirm Matching screen will display. Select Confirm to match any selected Issuance and 

Transaction items. Click the Cancel button to cancel without matching. 

 

 
 

10. Once Confirm is clicked, a success message will appear. 
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11. The paid transaction will now show the matched issue item data in Transaction History. 
 

 

 
 

12. Viewing the check data in the Item Lookup interface will show the complete audit history of the 

transaction. 
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VII. DECISION DUAL APPROVAL 
 
 

 

 

CHECK FRAUD ALERT offers the ability to support dual approval for client decisioning. If enabled by the 

FI and configured for a client, any transactions in a return status that are decisioned by the client will be 

held in “suspended” status until approved or rejected by a secondary user. 

 

 

 
 

If Decision Dual Approval is enabled, and a Client User has decisioned any transaction in the Transaction 

History to the status of User-Pay or has adjusted the serial number or amount of any transaction, approval 

will be requested to approve the change of the transaction status. The secondary client user must approve 

the transaction decision. 

 
 

1. Within the CHECK FRAUD ALERT module, click Perform > Transaction Approval. 
 
 
 

 
NOTE: 

 

➢ Client Decision Dual Approval permission must be enabled by the FI. 

➢ The Decision Dual Approval user privilege must be enabled. 
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2. The Check Transaction Approval screen will display. 
 
 

 
 
 

Select [all | none] The client user can opt to select individual transactions by clicking the checkbox at 
the left of the row. The client can also select all transactions by clicking “all” in the 
Select column. The client can de-select all transactions by clicking “none”. 

Account Number Displays the masked account number for the item. 

Current Serial Number The current serial number of the item. The client user can click the hyperlink in the 
serial number to view an image of the check. An eye icon denotes an item that 
has no serial number. 

Requested Serial Number The updated serial number, if changed by the client user performing the 
decisioning. 

Current Amount Original amount of the transaction. 

Requested Amount The updated amount, if changed by the client user performing the decisioning. 

Date Date of the transaction. 

Current Status Current status of the transaction. 

Requested Status The status of the transaction, if approved. 

Exception If the transaction is an exception, an exception identifier will appear in this column. 
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3. Clicking the arrow (>) at the far left of each row will expand the view for more pertinent information about 

the transaction. 

 

 
 
 

Transaction ID Unique ID assigned by the CHECK FRAUD ALERT system when 
transactions are loaded 

Requested By The client user who has requested the change of transaction status. 

Loaded Exception 
Reason 

The exception identified when the transaction was loaded. 

 
 
 

4. After examining the transactions pending approval, the client user can select items to approve or reject by 

clicking the Approve or Deny buttons at the bottom of the screen. 

 
5. If a transaction is Approved, a Confirm Approval pop-up window will appear. The user can click the 

Confirm button to confirm the approval of the transaction status change or click the Cancel button to 

return to the Check Transaction Approval Screen. 
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6. If a transaction is Rejected, a Confirm Rejection pop-up window will appear. The user can click the 

Confirm button to confirm the rejection of the transaction status change or click the Cancel button to 

return to the Check Transaction Approval Screen. 

 

 
 

7. Updating Transactions in Pending-Pay Status: 

 

In the case of No Issue transactions that are in Pending-Pay status awaiting approval or rejection, the 

user may do the following: 

 
a. Add Issue: A transaction currently in Pending-Pay status can be updated in the Transaction History 

page by expanding the view on the transaction and clicking the Add Issue button. 

 
Before changes, the transaction will appear without payee information as shown below. 

 

 

 
i. In Transaction History, click the Add Issue button. 
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ii. Complete the Add Issue pop-up screen by entering a Payee Name and clicking the Save button. 
 
 

 
 

iii. The changes will be reflected in the Transaction Approval screen, as shown below. 

 

 
 
 

b. Items currently in Pending-Pay status will not allow the user to adjust the serial number or amount. 
 
 
 
 

 
NOTE: 

 

➢ It is important to note that if a transaction decision is currently awaiting approval 

from a secondary client user and the transaction is not approved or rejected by 

EOD, the transaction will revert to its original status. For instance, if a transaction 

is set to default return and a client user decisions the item to be paid, if that 

decision is not approved by EOD, the item will revert to the default return status. 
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VIII. REPORTS 
 
 

 
 
 

 

 
 
 

A. Adjusted Items Report 
 

 

1. The Adjusted Items report is designed to allow the client user to view all transactions that are adjusted by 

the FI or client within the CHECK FRAUD ALERT system. 

 
2. From the CHECK FRAUD ALERT module, click Reports > Adjusted Items. 

 
 

 

 
NOTE: 

 

➢ Reports are available for one (1) year. 

NOTE: 
 

➢ The Adjusted Items Report user privilege must be enabled. 
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3. The Adjusted Items page appears. 

 

 
 
 

4. The Date Range field defaults to showing one day of transactions. To filter a longer date range of 

transactions shown, click on the Date Range drop-down. 
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5. To narrow search results, click Filters and a window containing additional search criteria will appear. 
 
 

 
 
 

Account Type an account name or the last 4 digits of the account number. 

Serial Number Type the item serial number for a specific issued item. A serial number range can also be 
defined by entering the minimum and maximum serial number. 

Min Amount Type the minimum dollar amount. 

Max Amount Type the maximum dollar amount. 

Adjustment Made By Select a user from the drop-down menu to filter to display only changes made by that user. 
Users can include FI or client users. 

 

 

6. Once search criteria are selected, click Apply to narrow your search results. 

 
7. Adjusted Items transactions are displayed in pages of 25 items. If the report contains more than 25 

transactions, the results will be displayed on multiple pages. Use the navigation buttons at the top of the 

report results to review all results. 
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Account Number Displays the Account Number for the adjusted item. 

R/T Number Displays the routing number associated with the adjusted item. 

Original Serial Number Displays the item original serial number. 

Serial Number Change Displays the serial number after item was adjusted. 

Encoded Amount Displays the original encoded amount of the item. 

Amount Changed To Displays the amount of the transaction after item was adjusted. 

Amount of Adjustment 
Needed 

Displays the total dollar amount difference between the encoded amount and the 
adjusted amount. 

Date Displays the date the item was adjusted. 

Adjustments Made By Displays the name of the user who adjusted the item. 

 
 
 

 

8. The entire Adjusted Items Report can be downloaded as a CSV file (Comma Separated Value). 

Click on the Download as CSV button at the bottom left of the Adjusted Items Report screen. 

 
 

B. Issue Item Status Report 
 
 

 

1. Within the CHECK FRAUD ALERT Module, click Reports > Issue Item Status. 
 

 

 
NOTE: 

 

➢ The Issue Item Status Report user privilege must be enabled. 
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2. The Issue Item Status Report page appears. The page will default to Outstanding items but can be 

changed to Paid items or Returned items. 
 

 
 
 

Issuance Status Outstanding Any items that have not been matched and decisioned yet. 

 
Paid Any items that have been matched and paid. 

 
Returned Any items that have been matched and returned. 

 
Stops Any items that have a stopped status 

 
Voids Any items that have a voided status. 

Start Date The start date is only applicable when filtering by Paid or Returned Issuance Status. 

End Date The end date will default to the current date. 

Summary Information 
Only 

Will show summary, rather than detailed, information on the displayed data. 

Account To further narrow down the results the report can be filtered by a specific account. 

 
 
 

3. Once search criteria are selected, click Apply to narrow your search results. 

 
 

4. Search results are displayed in pages of 25 items. If the search contains more than 25 transactions, the 

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results to 

review all results. 
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5. The Issue Item Status report will populate below the search window based on filters selected. 

 
a. Filtering for Outstanding Issuance Status: 

 

 
 
 

Account Number Displays the masked account number. 

Serial Number Displays the serial number for the item. 

Payee Name Displays the payee name, if applicable. 

Amount Displays the amount of the issuance item. 

Issuance Date Displays the date of the issuance item. 
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b. Filtering for Paid Issuance Status: 

 

 
 
 

Account Number Displays the masked account number. 

Serial Number Displays the serial number for the item. 

Payee Name Displays the payee name, if applicable. 

Issuance Amount Displays the amount of the issuance item. 

Issuance Date Displays the date of the issuance item. 

Transaction Amount Displays the amount of the presented item. 

Payment Date Displays the payment date of the item. 
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c. Filtering for Returned Issuance Status: 
 

 

 
 
 

Account Number Displays the masked account number. 

Serial Number Displays the serial number for the item. 

Payee Name Displays the payee name, if applicable. 

Issuance Amount Displays the amount of the issuance item. 

Issuance Date Displays the date of the issuance item. 

Transaction Amount Displays the amount of the presented item. 

Return Date Displays the return date of the item. 
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d. Filtering for Stops: 

 

 
 
 

Account Number Displays the masked account number. 

Serial Number Displays the serial number for the item. 

Payee Name Displays the payee name, if applicable. 

Issuance Amount Displays the amount of the issuance item. 

Issuance Date Displays the date of the issuance item. 

 

 

e. Filtering for Voids: 

 

 
 

 
Account Number Displays the masked account number. 

Serial Number Displays the serial number for the item. 

Payee Name Displays the payee name, if applicable. 

Issuance Amount Displays the amount of the issuance item. 

Issuance Date Displays the date of the issuance item. 
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6. If the Summary Information Only checkbox was selected, the Issue Item Status report will populate with 

summary information as shown in the graphic below. 

 

 
 
 

Account Number Displays the masked account number. 

Account Name Displays the name of the account. 

Check Status Displays the status of the issued items. 

Total Items Displays the total amount of items with a particular check status for a specific 
account. 

Total Dollar Amount Displays the total dollar amount of all items in the row. 

Grand Total Displays the grand total dollar amount of all items displayed in the rows above. 

 
 
 
 

7. The entire Issue Item Status Report can be downloaded as a CSV file (Comma Separated Value). Click 

on the Download as CSV button at the bottom left of the Issue Item Status Report screen. 
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IX. PAYEE POSITIVE PAY TIPS & BEST PRACTICES 
 
 

 

 

For client users to have the best user experience possible, we have outlined some best practices to help 

make the onboarding process more efficient. 

 
 

 
 
 

 

A. Payee Name Comparison: “Scoring” 

 
CHECK FRAUD ALERT payee name scoring can reasonably handle a variety of check styles, fonts, and 

even hand- written names on a payee line. However, it is important to note that scoring does not indicate 

with 100% certainty if the payee name on a check matches the payee name provided with the issue item 

information. 

The technology scores on the likelihood of a match and will fail or pass an item based on the scoring 

threshold set. The system supports a range of 0-1000. The lower the threshold is set, the more likely it is 

that fraudulent items will pass. The higher the threshold is set, the less likely they are to pass, but the flipside 

is items where there is an exact match could trigger unnecessary exceptions. 

CHECK FRAUD ALERT default threshold is set at 500. This is not a recommendation by ACH Alert, it is simply 

a system default that each financial institution can have raised or lowered based on their risk tolerance. In 

addition to establishing a global scoring threshold, FI’s can customize the default on an account by account 

basis. 

Each institution should consider incorporating language into their client agreements to explain that payee 

comparison is a scoring methodology that can be impacted by a variety of factors and therefore, as their 

financial institution, you make no representations or warranties that the technology is going to score items 

correctly each and every time. 

While CHECK FRAUD ALERT does allow FI users to pre-scrub exceptions and override false exceptions after 

visually inspecting the check, FI’s can help their clients reduce the number of false exceptions by 

recommending they use the best possible check design and formats as outlined in the best practices below. 
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B. Ideal Check Formatting 
 

Customers will find the most success following these suggestions in their check designs and format. 
 

• Paper weight should be 24” MICRBond (to ensure better image quality when physically captured with 

reader). 

 
• Use check stock with no backgrounds or lighter colored backgrounds and no logos or marks in the 

payee field. Any background patterns, images or watermarks on the check stock that is within the 

area of the data to be recognized can interfere with recognition results. [Please refer to Figures 1.1 

and 1.2 at the end of this subsection for good and bad examples] 

 
• Check stock should be consistent for each account. 

 
• Minimum 200 dpi resolution required; 600 dpi or higher resolution preferred. 

 
• Printing with an ink jet or laser printer will produce best results. 

 
• Check printing should be consistent with the payee information in the same location per account. 

 
• Checks should be fixed width (fixed spacing) 10-point font or higher for the Payee Block and Amount. 

Font size 12 or 14 will produce best results. [Please refer to Figures 1.3 and 1.4 at the end of this 

subsection for good and bad examples] 

 
• Sans Serif fonts are preferred (no bold). For example, Courier New, Courier, Lucida Console, 

Terminal, Letter Gothic are all acceptable fonts. Courier New is preferable. [Please refer to Figures 

1.3 and 1.4 at the end of this subsection for good and bad examples] 

 
• “PAY TO THE ORDER OF” should not be italicized or underlined and must be printed horizontally at 

the same level to the left of the payee name. Payee Name should be printed to the right of “PAY TO 

THE ORDER OF” starting from the position of the keyboard “PAY” or lower. [Please refer to Figures 

1.5 and 1.6 at the end of this subsection for good and bad examples] 

 
• Payee name should be a maximum of 100 characters, left aligned and single line spacing should be 

used. [Please refer to Figures 1.7 and 1.8 at the end of this subsection for good and bad 

examples] 

 
• Up to four payee names are permitted. [For more information about multiple payee handling, 

please refer to Subsection D, Multiple Payee Handling, within this section] 

 
• The payee name and amount should be surrounded by an area of white space, minimum of 2 empty 

lines. This will minimize the interference of any irrelevant printed information on the item and allow for 

some shifting/offset of the data’s location during the scanning process. [Please refer to Figures 1.7 

and 1.8 at the end of this subsection for good and bad examples] 
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• Payee name should not be italicized, bolded or underlined and words should be separated by one (1) 

single blank space. [Please refer to Figures 1.7 and 1.8 at the end of this subsection for good 

and bad examples] 

 
• Payee Name should be printed only once on the check, within the Payee Block. Do not split the 

Payee Block into two non-adjacent parts (the Name and the Address). [Please refer to Figures 1.7 

and 1.8 at the end of this subsection for good and bad examples] 

 
• Uppercase characters will produce best results. [Please refer to Figures 1.7 and 1.8 at the end of 

this subsection for good and bad examples] 
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Figure 1.1 
 

Good Example: A check stock that is light colored, with no logos in the payee field. 
 

 
 

Figure 1.2 
 

Bad Example: A check with a background that is too dark and may cause issues when scanning. 
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Figure 1.3 
 

Good Example: Payee Block and Amount use fixed width spacing, 12-14 font size sans serif fonts. 
 

 

 
Figure 1.4 

 

Bad Example: Serif font is used, non-fixed-width spacing and bolded font that is less than a 12-14 font size. 
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Figure 1.5 
 

Good Example: “Pay to the Order Of” is horizontally printed at the same level as the payee name. The font is not 

italicized or underlined. 
 

 

 
Figure 1.6 

 

Bad Example: “To The Order Of” appears instead of “Pay To The Order Of” and is not horizontally printed next to the 

Payee Block. The font is italicized. 
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Figure 1.7 
 

Good Example: Payee name and amount surrounded by an area of white space. Payee name is left aligned and 

single spaced. Payee name printed in uppercase letters, and is not italicized, bolded or underlined. The payee name 

is not split into non-adjacent parts and printed only once on the check. 
 

 

 
Figure 1.8 

 

Bad Example: Payee name not surrounded by white space. Font is bolded and upper and lowercase letters are 

used in the payee block. Payee name is in a separate area than the payee address and therefore is not left aligned. 
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C. Other Common Check Formatting Problems 

 
Following are some examples of check formats which cause processing errors and issues with payee 

scoring. 

 
Bad Scans & Poor Image Quality 

 

Poor image quality can interfere with scans. 
 

It appears the check paper was inserted into the printer improperly, causing the payee name 

information to print in a blurred/slanted condition and therefore cause issues with scanning. [Payor 

name, Payee name and bank name partially removed for confidentiality] 
 

 

Poor Image Quality. Payee area only states “To the Order of” and is not horizontally printed. The 

boxes around date and amount might cause issues with scanning. 
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Poor image quality. Check fields are in non-serif fonts. Boxes around check fields may cause issues 

with scanning. Pay To The Order Of is not horizontally printed. 

 

 
 

D. Multiple Payee Handling 

 

CHECK FRAUD ALERT has the ability to support customers with multiple payee names on issued items. 

CHECK FRAUD ALERT can score multiple names on a check against information provided in the 

issuance file. Multiple payees can be listed on a single line, or on two separate lines on the check. 

Examples of correct formatting are shown below. 
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1. This section is designed to explain how to handle multiple payee names that will appear on two separate 

lines of the check. 

 
a. Multiple Payee Handling setup in Issue Templates. 

 

i. The Multi-Line Payee Name Separator field is included in the Issue Template creation screen 

that allows for recognition and recording of multiple payees on a check. 

 

 
 
 
 

ii. This feature allows the FI or Client user to enter a character into the field that can be used to 

separate Multiple Payee Names that are on separate lines of an issued item. Currently, the 

system restricts the allowed characters to the following: ; | , - _ / . The user must be aware that 

using a separator character that appears elsewhere in the payee name or might conflict with the 

file itself can cause issues. Examples of scenarios where problems might arise are listed below. 

 
Within a Comma Separated file (.csv), different data fields are separated by a comma. It is 

important to note that a comma cannot be used in the data field itself, or the .csv will read the 

comma as a separator before the next field. Therefore, listing two payees for an item in this way: 

“Elain Archeron,Nesta Archeron” will cause issues reading the .csv file. In this scenario, the user 

should select a multi-line payee name separator character that will not cause an issue, such as a 

semicolon. “Elain Archeron;Nesta Archeron” in the Payee Name field of the .csv file will process 

correctly. 

 

 
If the user selects a separator character that would ever appear in a payee name field, such as a 
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dash (-), the system would then separate the data before and after the character as separate 

payees. For instance, if the user has selected a dash (-) as the Multi-Line Payee Name 

Separator, and a common payee used is “In-and-Out Burger”, the system will flag this as having 

multiple payees. In this case, the user should select a multi-line payee name separator that will 

not cause such issues, such as a pipe (|) or a semicolon for cases of multiple payee names. 

 
b. Multiple Payee Handling in Manual Issue Entry. 

 

i. When the Client user performs Manual Issue Entry, the Payee Name field supports up to four 

Payees. When in the Manual Issue Entry screen, the names should be listed as shown below. An 

Enter (carriage return) must be used to input the second, third or fourth payee on separate lines 

in the field for it to be distinguished as different payees. Example of Manual Issue Entry and 

corresponding issue item below: 
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ii. If the multiple payees are listed on a single line of the check, putting the names on separate lines 

is not applicable. Example of Manual Issue Entry and corresponding issue item below: 

 
 

 
 

 
 

iii. It is important to note that the Payee Name field currently supports 100 characters in total. This 

character limit includes the carriage returns separating multiple payees. The 100- character limit 

is for the entire field, and not per payee. 

 
Manual Issue Entry is covered in depth in the CHECK FRAUD ALERT Client User Guide. Please 
refer to this document for more general information about Manual Issue Entry. 

 

 
c. Multiple Payee Handling when Loading Issue Files. 

 

i. When the Client user loads issue files to the system, the loaded file is processed with an Issue 

Template set up within CHECK FRAUD ALERT. The Issue Template allows for selection of a 

Multi-Line Payee Separator, a character chosen to separate the names of multiple payees in the 

issue file. 

 
ii. If multiple payees are listed on a single line of a check, no action needs to be taken. 
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iii. If multiple payees are listed on two or more separate lines on a check, the multiple payee 

separator character (which should match the one designated in the template), must be used 

between each name. Example of an issue file and corresponding issue item below: 

 

 
 

 
 

Loading Issue Files is covered in depth in the CHECK FRAUD ALERT Client User Guide. 

Please refer to this document for more general information about Loading Issue Files. 
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d. Things to Remember: Multiple Payee Name Separators. 

 

To recap the information covered above, remember: 

 
i. The Multi-Line Payee Name Separator character designated in the Issue Template must match 

what is used in the Issue Files loaded to the system. The system will recognize that character and 

when encountered in an Issue File, will record the data appearing after that character as a 

separate payee. 

 

ii. The allowable characters are: ; | , - _ / . 

 
iii. Some characters may cause problems when used as a separator. Do not use a character as a 

separator if that character will ever be present in a Payee Name, or is a character used in a 

specific file type (i.e., Comma Separated files). 

 
iv. Payee Name Separators are only necessary when payee names are listed on two or more 

separate lines of a check. 
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X. PREFERENCES 
 
 

 

 

A. Preferences 
 

1. From within the Dashboard or CHECK FRAUD ALERT Module, click User’s Name > Preferences. 
 
 

 

 
 

2. The Preferences page appears. 
 

 

 

 
3. Default Module gives the User the ability to choose the default landing page. 
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4. Default CHECK FRAUD ALERT Page allows the user to select the default landing page within CHECK 
FRAUD ALERT. 

 

 
 

 
5. Default Dashboard Page allows the user to select the default landing page within the Client Dashboard. 

 

 
 
 

6. Once any preferences have been selected, click Save to update the settings. 

 



 

APPENDIX A – CHECK FRAUD ALERT MESSAGE ALERTS 
 
 

This Appendix illustrates the different types of alerts users may receive while using CHECK FRAUD 

ALERT. Please note the following: 

• If a cell phone number is entered in the Cell Phone Number field in the user’s setup (FI or Client user), the user may receive SMS/Text Alerts if the 

user is set up for CHECK FRAUD ALERT and/or C.O.P.S. 

• Service Level Alerts are not included in this list, as they apply only to CHECK FRAUD ALERT, PRO-TECH, PRO-TECH CR and EDI TransAlert. 

Please be aware that if a user is set to receive Service Level Alerts, the user will receive a service level alert for all the client’s accounts, which 

may include accounts a user is not assigned to work with. 

• As of March 3, 2022, ACH Alert has transitioned to a 10-digit long code (10DLC) number for generating SMS/Text Alerts. The long code number 

which will appear in any SMS/Text Alerts received will be 12029808159. This number may appear formatted as a regular ten-digit phone number 

(1-202-980-8159). 

 

 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Cleanup 
Reminder 
Alert (Email) 

 

 

An alert per account sent to 
users when a file is loaded after 
the cleanup deadline which 
requires attention before EOD. 

FI & Client 

CHECK 
FRAUD 
ALERT 
Cleanup 
Reminder 
Alert 
(SMS/Text) 

 

 

An alert per account sent to 
users when a file is loaded after 
the cleanup deadline which 
requires attention before EOD. 

FI & Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
EOD 
Completed 
(Email) 

 

 

An alert notifying that EOD has 
been completed and listing the 
day’s return count. 

FI & Client 

CHECK 
FRAUD 
ALERT 

Issuance 
EOD 
Completed 
(Email) 

 

 

If the FI has enabled the 
Release Issue Files flag in the 
admin portal, issue files will be 
held until the issuance file 
deadline hour. This alert is sent 
notifying that Issuance EOD has 
been reached. 

FI & Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Issuance 
File 
Generated 
(Email) 

 

 

If FI is sending issue files to 
ACH Alert on behalf of Clients, 
this alert is sent to users with the 
system alerts flag enabled when 
an issue file is generated. 

FI & Client 

CHECK 
FRAUD 
ALERT 

Account 
Level 
Notification 
for All 
Checks 
(Email) 

 

 

An alert per account sent to 
users for exceptions and any 
matched items. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Account 
Level 
Notification 
for All 
Checks 
(SMS/Text) 

 

 

An alert per account sent to 
users for exceptions and any 
matched items. 

Client 

CHECK 
FRAUD 
ALERT 
Account 
Level 
Notification 
for 
Exceptions 
(Email) 

 

 

An alert per account when one 
or more exceptions exist that 
require a decision. 

Client 

CHECK 
FRAUD 
ALERT 
Account 
Level 
Notification 
for 
Exceptions 
(SMS/Text) 

 

 

An alert per account when one 
or more exceptions exist that 
require a decision. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Transaction 
Level 
Notification 
for All 
Checks 
(Email) 

 

 

An alert per transaction that a 
check may require a decision 

Client 

CHECK 
FRAUD 
ALERT 
Transaction 
Level 
Notification 
for All 
Checks 
(SMS/Text) 

 

 

An alert per transaction that a 
check may require a decision. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Transaction 
Level 
Notification 
for 
Exceptions 
(Email) 

 

 

An alert per transaction when an 
exception exists that requires a 
decision. 

Client 

CHECK 
FRAUD 
ALERT 
Transaction 
Level 
Notification 
for 
Exceptions 
(SMS/Text) 

 

 

An alert per transaction when an 
exception exists that requires a 
decision. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Issuance 
Load Failure 
Client Alert 
(Email) 

 

 

If the FI has enabled this feature 
for Clients, this alert will be sent 
to Clients with the issue load 
alerts privilege enabled when an 
issue file loaded through the 
Client portal has issues that 
prevent it from loading 
successfully. 

Client 

CHECK 
FRAUD 
ALERT 
Issuance 
Load Failure 
Client Alert 
(SMS/Text) 

 

 

If the FI has enabled this feature 
for Clients, this alert will be sent 
to Clients with the issue load 
alerts privilege enabled when an 
issue file loaded through the 
Client portal has issues that 
prevent it from loading 
successfully. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Issuance 
Load 
Success 
Client Alert 
(Email) 

 

 

If the FI has enabled this feature 
for Clients, this alert will be sent 
to Clients with the issue load 
alerts privilege enabled when an 
issue file loaded through the 
Client portal loads successfully. 

Client 

CHECK 
FRAUD 
ALERT 
Issuance 
Load 
Success 
Client Alert 
(SMS/Text) 

 

 

If the FI has enabled this feature 
for Clients, this alert will be sent 
to Clients with the issue load 
alerts privilege enabled when an 
issue file loaded through the 
Client portal loads successfully. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Issuance 
Load with 
Ineligible 
Items – 
Client Alert 
(Email) 

 

 

If the FI has enabled this feature 
for Clients, this alert will be sent 
to Clients with the issue load 
alerts privilege enabled when an 
issue file loads with ineligible 
items that prevented the file from 
loading successfully. 

Client 

CHECK 
FRAUD 
ALERT 
Issuance 
Load with 
Ineligible 
Items – 
Client Alert 
(SMS/Text) 

 

 

If the FI has enabled this feature 
for Clients, this alert will be sent 
to Clients with the issue load 
alerts privilege enabled when an 
issue file loads with ineligible 
items that prevented the file from 
loading successfully. 

Client 

CHECK 
FRAUD 
ALERT 
EOD 
Reminder 
Alert (Email) 

 

 

This alert will be sent to Client 
users with the Change 
Transaction Status user privilege 
if exceptions exist and a user 
with Change Transaction Status 
has not logged into the system 
at the FI’s designated time. This 
alert option will only be available 
if enabled by the financial 
institution. 

 

If alert method for CHECK 
FRAUD ALERT is set to “None” 
for a Client user, they will not 
receive the EOD 
reminder alert. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
EOD 
Reminder 
Alert 
(SMS/Text) 

 

 

This alert will be sent to Client 
users with the Change 
Transaction Status user privilege 
if exceptions exist and a user 
with Change Transaction Status 
has not logged into the system 
at the FI’s designated time. This 
alert option will only be available 
if enabled by the financial 
institution. 

 
If alert method for CHECK 
FRAUD ALERT is set to “None” 
for a Client user, they will not 
receive the EOD 
reminder alert. 

Client 

CHECK 
FRAUD 
ALERT 
Dual 
Decision 
Approval 
Reminder 
Alert (Email) 

 

 

An alert sent to inform user that 
transactions involving dual 
decision approval are waiting to 
be approved or rejected. 

Client 

CHECK 
FRAUD 
ALERT 
Dual 
Decision 
Approval 
Reminder 
Alert 
(SMS/Text) 

 

 

An alert sent to inform user that 
transactions involving dual 
decision approval are waiting to 
be approved or rejected. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Issuance 
Dual 
Approval 
Reminder 
Alert (Email) 

 

 

An alert sent to inform user that 
an issuance file involving dual 
approval is waiting to be 
approved or rejected. 

Client 

CHECK 
FRAUD 
ALERT 

Issuance 
Dual 
Approval 
Reminder 
Alert 
(SMS/Text) 

 

 

An alert sent to inform user that 
an issuance file involving dual 
approval is waiting to be 
approved or rejected. 

Client 

CHECK 
FRAUD 
ALERT 

Service 
Level Alert 
(Email) 

 

 

A service level alert sent to 
users to notify that transactions 
are available to decision. 

Client 



 

Alert Type Example Image Description Recipient 

CHECK 
FRAUD 
ALERT 
Service 
Level Alert 
(SMS/Text) 

 

 

A service level alert sent to 
users to notify that transactions 
are available to decision. 

Client 



 

APPENDIX B – QUICKBOOKS ISSUE FILE EXPORT 
 
 

 

 

This guide is meant to aid client users in exporting check file data from QuickBooks. There are two methods 

of exporting the check file data from QuickBooks. Both options are outlined below. These examples are from 

the QuickBooks desktop version. The first option is using a Quick Report from the checking account. The 

second method is using the Check Detail Report, which requires more actions for the user to take. 

 
 

A. Exporting from QuickBooks Account Register 

 
1. From QuickBooks, use Ctrl+A to open the account listing from any screen. 

 
2. Click once to select the appropriate account to pull the Check File. 

 

 
 
 

3. Once the Check Report has been populated, use Ctrl+Q to create a Quick Report from the selected 

account. 
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a. Select the Date drop-down menu to choose a specific date or date range for the transactions to 

display in the report. Based on the range that is selected, check items that can be displayed can be 

for a specific date, a specific quarter, month or even a date range that the user selects. 

 

 
b. Click Customize Report button. The Modify Report screen displays. By using the Customize Report 

feature, the user will be able to manage the amount of information contained in the report prior to 

exporting the report to Excel. The user can select and/or remove items that are not needed in the 

report. 

 



Version 2.1.5 
Updated 06/24/2022 

Page 166 of 177 

© 2022 ACH Alert 
Proprietary & Confidential Information 

 

c. Click the Filters tab. In the listing of Filters, select Transaction Type. This will allow the user to remove 

the transaction types that are needed for the check file. 
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d. From the Transaction Type drop-down menu, select Multiple Transaction Types. This will allow the 

user to select multiple check types within QuickBooks. For this example, we have used Check and 

Bill Payment. Click OK to confirm the transaction types. 

 
 



Version 2.1.5 
Updated 06/24/2022 

Page 168 of 177 

© 2022 ACH Alert 
Proprietary & Confidential Information 

 

e. From the Modify Report screen, select OK to proceed. The requested changes to the report will 

display. 

 

 
f. From the QuickBooks toolbar, click the Excel drop-down menu and select Create New Worksheet. 
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g. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New 

Worksheet and click the Export button to continue. 

 

 

 
h. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank 

under the column header “Num”. By removing these items from the check file, items that do not have 

a serial number assigned to them will not be uploaded into the CHECK FRAUD ALERT System. 

 

 
 
 
 
 
 

 
i. Remove the “Balance” column. This information is not needed for the Check File upload to 

CHECK FRAUD ALERT. 
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j. Select File > Save As and save the workbook. 

 
i. Choose the File Name. 

 
ii. Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003 

Workbook or Excel Workbook. 

 
 

 
 

k. Click Save and close the workbook. 
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4. Sign into the ACH Alert Client Portal. 
 
 
 

 
 

5. Select the CHECK FRAUD ALERT Service Module. 

 

 
 
 

6. From the CHECK FRAUD ALERT module, select Manage > Issue Templates to create an issue 

template. This will allow the user to map the exported information from QuickBooks so that the file is 

read correctly when uploaded to CHECK FRAUD ALERT. The user will also be able to save this 

template for use in future issuance file uploads. 
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7. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for 

the Client to use and allows the user to create a new template for use. Select Create New Template. 

 
 

 
8. The Create New Template screen appears. 
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9. Creating the Issuance Template to the Exported Information from QuickBooks: 

 

a. Template Name 

 
Create a name for the template using information that will allow the user to easily identify this 

template in the future. For this example, the template name is QuickBooks Export Type 1. 

 

 
 
 

b. File Type 

 
Select the appropriate file type based on the file type used to save the Excel document. For this 

example, the file type will be Excel Workbook. 

 

 

c. Template Status 

 
The Template Status drop-down menu defaults to Active status. Leave the status as Active. 
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d. Number of Header Rows 

 
Refer to the Excel file that was created. A Header Row will be any row above the check information 

that does not contain actual check information for presentment in the CHECK FRAUD ALERT 

Module. For this example, the header rows have been highlighted yellow. The number of header 

rows should be 2 in the template. 

 

 

 
e. Number of Footer Rows 

 
Refer to the Excel file that was created. A Footer Row will be any row below the check information 

that does not contain actual check information for presentment in the CHECK FRAUD ALERT 

Module. For this example, the footer rows have been highlighted yellow. The number of footer rows 

should be 2 in the template. 
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f. Template Level 

 
The default value of Client will be presented and will not allow a different selection to be made. 

 
 

g. Multi-Line Payee Name Separator. 

 
This feature is not currently available for items exported out of QuickBooks. 

 
 

 

 
h. File Mapping 

 
i. Serial Number 

 
1. Enter the column number that the check number/serial number is presented in the Excel 

document. For this example, the Num column is highlighted yellow. The column number for 

Num should be 9 in the template. 
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ii. Amount 

 
1. Enter the column number that the amount is presented in the Excel document. Select 

fractional dollars if the dollars and cents are separated by a decimal. If the dollars and cents 

are not separated by a decimal, select whole numbers of cents. For this example, the Amount 

column is highlighted yellow. The column number for Amount should be 17 in the template. 

 
 
 

 
iii. Status 

 
1. Remove the checkmark from this box. The export from QuickBooks does not contain this 

information. The user can add this information manually if they choose to. If the column is 

added, the box will need to remain checked and the column number will need to be entered 

for the CHECK FRAUD ALERT system to accurately read it. For this example, the Status field 

is not being used. 

 

 
If the Status box is unchecked, the user should be aware that any issuance loaded with 

negative amounts or a $0 amount will be treated as Void. 
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iv. Account Number 

 
1. The exported information from QuickBooks does not include an account number. Leave the 

box unchecked and the File Column field blank. For this example, the Account Number field is 

left blank. 

 

 
 
 
 

v. Issuance Date 

 
1. The Issuance Date is located in the “Date” column in the Excel document. The user must 

check the box and enter the column number for the system to read the issuance date 

correctly. For this example, the Date column is highlighted yellow. The column number for 

Issuance Date should be 7 in the template. 
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vi. Payee Name 

 
1. If the Client is set up to use Payee Positive Pay, the user will need to select the box and enter 

the column number for the column labeled “Name” in the Excel report. For this example, the 

Name column is highlighted yellow. The column number for Payee Name should be 11 in the 

template. 

 

 

 
vii. Additional Issue Fields 

 
1. Additional issue fields are available for client use to allow clients to record any additional 

information into an issuance file to be used for historical or reconciliation purposes. In the 

example below, the client has additional issue fields configured: Company Name, Invoice, 

and Address. For the purposes of Export from QuickBooks, the user should disregard these 

fields as they do not apply to the export process. 
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viii. Click the Save button. A success message appears, and the user will be returned to the 

Issuance Templates page. The new issue template will display in the list of templates. 

 

 
 

 

B. Exporting from QuickBook Reports 

 
1. From QuickBooks, select Reports on the Tool Bar. 
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2. Select Banking from the drop-down menu and click Check Detail from the Banking sub-menu. 
 

 

 
 

3. The Check Detail Report will display. 
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a. Select the Date drop-down menu to choose a specific date or date range for the check items to 

display in the report. Based on the range that is selected, check items that can be displayed can be 

for a specific date, a specific quarter, month or even a date range that the user selects. 

 

 

 
b. Click Customize Report button. The Modify Report screen displays. 
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c. Select the Filters tab. 
 
 

 

 
d. In the listing of Filters, select Account from the drop-down menu. 

 
i. Select All Bank Accounts to pull all checks issued from all bank accounts for which the user has 

QuickBooks access. 
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ii. Select a single Bank Account to pull checks issued from a single bank account. 
 
 

 

 
iii. Under Include Split Detail?, click the button next to “No”. 
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iv. Under Current Filter Choices, select Detail Level, and then click the Remove Selected Filter 

button. 

 

 

v. Select Transaction Type from the Filter menu. Select Multiple Transaction Types from the 

Transaction Types submenu. 
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vi. From the Select Transaction Type drop-down menu, select the check transactions to appear in 

the Check File. For this example, Check and Bill Payment options were selected. Click OK to 

confirm the transaction types. 

 

 

 
e. From the Modify Report screen, select OK to proceed. The requested changes to the report will 

display. From the QuickBooks toolbar, click the Excel drop-down menu and select Create New 

Worksheet. 
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f. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New 

Worksheet and click the Export button to continue. 

 

 
g. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank 

under the column headers “Type” and/or “Num”. 
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h. Remove all blank columns. 
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i. Select File > Save As and save the workbook. 

 
i. Choose the File Name. 

 
ii. Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003 

Workbook or Excel Workbook. 

 

 
 

j. After saving, close the Excel workbook. 
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4. Sign into the ACH Alert Client Portal. 
 
 
 

 
 

5. Select the CHECK FRAUD ALERT Service Module. 

 

 

6. From the CHECK FRAUD ALERT module, select Manage > Issue Templates to create an issue 

template. This will allow the user to map the exported information from QuickBooks so that the file is 

read correctly when uploaded to CHECK FRAUD ALERT. The user will also be able to save this 

template for use in future issuance file uploads. 
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7. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for 

the Client to use and allows the user to create a new template for use. Select Create New Template. 

 
 

 
8. The Create New Template screen appears. 
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9. Creating the Issuance Template to the Exported Information from QuickBooks: 
 
 

a. Template Name 

 
Create a name for the template using information that will allow the user to easily identify this 

template in the future. For this example, the template name is QuickBooks Export Type 2. 

 

 
 

 
b. File Type 

 
Select the appropriate file type based on the file type used to save the Excel document. For this 

example, the file type will be Excel Workbook. 

 

 

 
c. Template Status 

 
The Template Status drop-down menu defaults to Active status. Leave the status as Active. 
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d. Number of Header Rows 

 
Refer to the Excel file that was created. A Header Row will be any row above the check information 

that does not contain actual check information for presentment in the CHECK FRAUD ALERT 

Module. For this example, the header rows have been highlighted yellow. The number of header 

rows should be 2 in the template. 

 

 

 
e. Number of Footer Rows 

 
Refer to the Excel file that was created. A Footer Row will be any row below the check information 

that does not contain actual check information for presentment in the CHECK FRAUD ALERT 

Module. For this example, the footer rows have been highlighted yellow. The number of footer rows 

should be 2 in the template. 
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f. Template Level 

 
The default value of Client will be presented and will not allow a different selection to be made. 

 
 

g. Multi-Line Payee Name Separator. 

 
This feature is not currently available for items exported out of QuickBooks. 

 

 

h. File Mapping 

 
i. Serial Number 

 
1. Enter the column number that the check number/serial number is presented in the Excel 

document. For this example, the Num column is highlighted yellow. The column number for 

Amount should be 2 in the template. 
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ii. Amount 

 
1. Enter the column number that the amount is presented in the Excel document. Select 

fractional dollars if the dollars and cents are separated by a decimal. If the dollars and cents 

are not separated by a decimal, select whole numbers of cents. For this example, the Amount 

column is highlighted yellow. The column number for Amount should be 6 in the template. 

 

 

iii. Status 

 
1. Remove the checkmark from this box. The export from QuickBooks does not contain this 

information. The user can add this information manually if they choose to. If the column is 

added, the box will need to remain checked and the column number will need to be entered 

for the CHECK FRAUD ALERT system to accurately read it. For this example, the Status field 

is not being used. 

 

If the Status box is unchecked, the user should be aware that any issuance loaded with 

negative amounts or a $0 amount will be treated as Void. 
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iv. Account Number 

 
1. The exported information from QuickBooks does not include an account number. Leave the 

box unchecked and the File Column field blank. For this example, the Account Number field is 

left blank. 

 

 
 
 
 

v. Issuance Date 

 
1. The Issuance Date is located in the “Date” column in the Excel document. The user must 

check the box and enter the column number for the system to read the issuance date 

correctly. For this example, the Date column is highlighted yellow. The column number for 

Issuance Date should be 3 in the template. 
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vi. Payee Name 

 
1. If the Client is set up to use Payee Positive Pay, the user will need to select the box and enter 

the column number for the column labeled “Name” in the Excel report. For this example, the 

Name column is highlighted yellow. The column number for Payee Name should be 4 in the 

template. 
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vii. Additional Issue Fields 

 
1. Additional issue fields are available for client use to allow clients to record any additional 

information into an issuance file to be used for historical or reconciliation purposes. In the 

example below, the client has additional issue fields configured: Company Name, Invoice, 

and Address. For the purposes of Export from QuickBooks, the user should disregard these 

fields as they do not apply to the export process. 
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i. Click the Save button. A success message appears, and the user will be returned to the Issuance 

Templates page. The new issue template will display in the list of templates. 
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C. Loading the QuickBooks Issue File 

 
1. From the CHECK FRAUD ALERT Module, select Perform > Issue File Load. 

 

 
 

 
2. The Load Check Issuance File page appears. 

 
 

 
 

3. Select the Template drop-down box to select from a list of existing templates. Select the appropriate 

template. For this example, QuickBooks Export Type 2 will be used. 
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4. The template selected was created without the Account field enabled. A drop-down box will display so 

that the appropriate account can be selected. Select from the list of accounts. For this example, ABC 

Heating – xxxx1555 will be used. 

 

 

 
5. The file upload interface will appear. Click the Browse button to select the appropriate file or drag and 

drop the file into the box indicated on the interface screen. 
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6. Once the file is selected, it will be displayed in the upload interface. 
 
 

 

7. Click the Upload button to proceed. Once the file has loaded successfully, the Issuance File Status page 

will display and will be eligible for editing in the Issue Warehouse. 
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APPENDIX C – DOCUMENT REVISION INDEX 
 
 
 

A comprehensive list of all revisions made to this document since last publication. 
 

Previous Version: 2.1.4 (published 04/30/2022) 

Current Version: 2.1.5 (published 06/24/2022) 
 

Section Pages Description 

Entire Document  Miscellaneous screenshots updated to reflect minor 
changes in user interface. 

Section IV – Managing Issue Items p. 26 C. Manual Entry – Removed bullets from NOTE box 
related to back-dated issuance items, as CHECK 
FRAUD ALERT will now accept back-dated items, even 
from previous reconcilement periods. 

 p. 44 F. Loading Issue Files – Removed bullets from NOTE 
box related to back-dated issuance items, as CHECK 
FRAUD ALERT will now accept back-dated items, even 
from previous reconcilement periods. 

 p. 52 F. Loading Issue Files – Direct Send – Removed bullet 
from NOTE box related to back-dated issuance items, 
as CHECK FRAUD ALERT will now accept back-dated 
items, even from previous reconcilement periods. 

Section VI – Managing Check 
Presentment 

p. 89 A. Transaction History – Updated screenshot 
displaying the newly-added Add Notes button. 

 p. 90 A. Transaction History – Updated table with 
information regarding the newly-added Add Notes 
button. 

 p. 103 D. Add Notes – Added new subsection outlining the 
functionality of the newly-added Add Notes feature. 

Section IX – Reports p. 119-123 B. Issue Item Status Report – Updated subsection to 
include more useful information about Issue Item 
Status Report filtering functionality. 
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APPENDIX D – CLIENT USER TRAINING VIDEOS 
 
 

 
 
 

Client users can access the information contained in the CHECK FRAUD ALERT Client User Guide, 

presented in training video form, by navigating to the following link: 

 

https://bankcherokee.com/business-cash-management/check-fraud-alert/check-fraud-alert-tutorials/ 

 

 
 

 

https://bankcherokee.com/business-cash-management/check-fraud-alert/check-fraud-alert-tutorials/

